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1-2 Black Oil Tutorial Introduction
1.1 Black Oil Tutorial 
Introduction

In today’s oil and gas industry, it becomes increasingly 
necessary to use a compositional model and equation of state to 
accurately model the behaviour of a petroleum fluid downstream 
of the well and flowlines. The HYSYS Upstream Option translates 
from black oil to a compositional model using the gas 
composition and HYSYS oil characterization.

In HYSYS, Black Oil describes a class of phase behaviour and 
transport property models. Black oil correlations are typically 
used when a limited amount of oil and gas information is 
available in the system. Oil and gas fluid properties are 
calculated from correlations with their respective specific gravity 
(as well as a few other easily measured parameters).

Black Oil is not typically used for systems that would be 
characterized as gas-condensate or dry gas, but rather for 
systems where the liquid phase is a non-volatile oil (and 
consequently there is no evolution of gas, except for that which 
is dissolved in the oil).

In this Tutorial, two black oil streams at different conditions and 
compositions are passed through a mixer to blend into one black 
oil stream. The blended black oil stream is then fed to the Black 
Oil Translator where the blended black oil stream data is 
transitioned to a HYSYS material stream. A flowsheet for this 
process is shown below.

 Figure 1.1
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The following pages will guide you through building a HYSYS 
case for modeling this process. This example will illustrate the 
complete construction of the simulation, from selecting the 
property package and components, to installing streams and 
unit operations, through to examining the final results. The tools 
available in the HYSYS interface will be used to illustrate the 
flexibility available to you.

The simulation will be built using these basic steps:

1. Create a unit set and set the Black Oil default options.
2. Select the components.

3. Add a Neotec Black Oil property package.

4. Create and specify the feed streams.

5. Install and define the unit operations prior to the translator.

6. Install and define the translator.

7. Add a Peng-Robinson property package.
1-3



1-4 Setting the Session Preferences
1.2 Setting the Session 
Preferences

1. To start a new simulation case, do one of the following:
• From the File menu, select New and then Case.
• Click the New Case icon.
The Simulation Basis Manager appears:

Next you will set your Session Preferences before building a 
case.

2. From the Tools menu, select Preferences. 

 Figure 1.2

New Case icon
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The Session Preferences view appears. You should be on the 
Options page of the Simulation tab. 

3. In the General Options group, ensure the Use Modal 
Property Views checkbox is unchecked so that you can 
access multiple views at the same time.

1.2.1 Creating a New Unit Set
The first step in building the simulation case is choosing a unit 
set. Since HYSYS does not allow you to change any of the three 
default unit sets listed (in other words, EuroSI, Field, and SI), 
you will create a new unit set by cloning an existing one. For this 
example, a new unit set will be made based on the HYSYS Field 
set, which you will then customize.

To create a new unit set, do the following:

1. In the Session Preferences view, click the Variables tab.
2. Select the Units page if it is not already selected.

 Figure 1.3
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3. In the Available Unit Sets group, highlight Field to make it 
the active set. 

4. Click the Clone button. A new unit set named NewUser 
appears. This unit set becomes the currently Available Unit 
Set.

5. In the Unit Set Name field, rename the new unit set as 
Black Oil. You can now change the units for any variable 
associated with this new unit set.

In the Display Units group, the current default unit for Std 
Gas Den is lb/ft3. In this example we will change the unit to 
SG_rel_to_air.

6. Scroll through the table in the Display Units group, until you 
find the Std Gas Den variable.

 Figure 1.4

The default Preference 
file is named hysys.PRF. 
When you modify any of 
the preferences, you can 
save the changes in a 
new Preference file by 
clicking the Save 
Preference Set button. 
HYSYS prompts you to 
provide a name for the 
new Preference file, 
which you can load into 
any simulation case by 
clicking the Load 
Preference Set button.
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7. To view the available units for Std Gas Den, click the drop-
down arrow in the cell beside the Std Gas Den cell.

8. From the drop-down list, select SG_rel_to_air.

9. Repeat the previous three steps to change the Standard 
Density unit to SG_60/60 api.

Your Black Oil unit set is now defined. 

 Figure 1.5
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1.2.2 Setting Black Oil Stream 
Default Options

To set the Black Oil stream default options:

1. Click on the Oil Input tab in the Session Preference view.
2. In the Session Preferences view, select the Black Oils page.

In the Black Oil Stream Options group, you can select the 
methods for calculating the viscosity, and displaying the 
water content for all the black oil streams in your 
simulation. For now you will leave the settings as default.

3. Click the Close icon (in the top right corner) to close the 
Session Preferences view. You will now add the components 
and fluid package to the simulation.

 Figure 1.6

Close icon
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1.3 Setting the Simulation 
Basis

The Simulation Basis Manager allows you to create, modify, and 
manipulate fluid packages in your simulation case. As a 
minimum, a Fluid Package contains the components and 
property method (for example, an Equation of State) HYSYS will 
use in its calculations for a particular flowsheet. Depending on 
what is required in a specific flowsheet, a Fluid Package may 
also contain other information such as reactions and interaction 
parameters. You will first define your fluid package by selecting 
the components in this simulation case.

1.3.1 Selecting Components
HYSYS has an internal stipulation that at least one component 
must be added to a component list that is associated to a fluid 
package. To fulfil this requirement you must add a minimum of a 
single component even when the compositional data is not 
needed. For black oil streams, depending on the information 
available, you have the option to either specify the gas 
components compositions or the gas density to define the gas 
phase of the stream.
1-9



1-10 Setting the Simulation Basis
To add components to your simulation case:

1. Click on the Components tab in the Simulation Basis 
Manager.

2. Click the Add button. The Component List view is displayed.

3. In this tutorial, add the following components: C1, C2, C3, 
i-C4, n-C4, i-C5, n-C5, and C6.

4. Close the Component List View to return to the Simulation 
Basis Manager view.

If the Simulation Basis Manager is not visible, click the 

Home View icon  from the tool bar.

 Figure 1.7

For more information on 
adding and viewing 
components, refer to 
Chapter 1 - 
Components in the 
HYSYS Simulation 
Basis guide.
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1.3.2 Creating a Fluid Package
In this tutorial, since a Black Oil Translator is used in 
transitioning a Black Oil stream to a HYSYS compositional 
stream, two property packages are required in the simulation. 
You will first add the Neotec Black Oil property package and later 
in the tutorial after, you have installed the black oil translator, 
you will add the Peng-Robinson property package.

Adding the Neotec Black Oil Property 
Package
To add the Neotec Black Oil Property Package to your 
simulation:

1. From Simulation Basis Manager, click the Fluid Pkgs tab.
2. Click the Add button in the Current Fluid Packages group. 

The Fluid Package Manager appears.

3. In the Component List Selection group, select Component 
List - 1 from the drop-down list.

4. From the list of available property packages in the Property 
Package Selection group, select Neotec Black Oil. 

The Neotec Black Oil Methods view appears.

 Figure 1.8

You can also filter the list 
of available property 
packages by clicking the 
Miscellaneous Type 
radio button in the 
Property Package Filter 
group. From the filtered 
list you can select 
Neotec Black Oil.
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1-12 Setting the Simulation Basis
The Neotec Black Oil Methods view displays the nine PVT 
behaviour and transport property procedures, and each of 
their calculation methods.

5. In this tutorial, you want to have the Watson K Factor 
calculated by the simulation. The default option for the 
Watson K Factor is set at Specify. Thus, you will change 
the option to Calculate from the Watson K Factor drop-
down list, as shown below.

6. Click the Close button to close the Neotec Black Oil Methods 
view.

The HYSYS Neotec Black Oil view appears.

7. In the Basis field, type in the new name Black Oil for the 
fluid package.

8. Close the HYSYS Neotec Black oil view by clicking the Close 
icon.

The Black Oil fluid package is now completely defined. If you 
click on the Fluid Pkgs tab in the Simulation Basis Manger 
you can see that the list of Current Fluid Packages now 

 Figure 1.9

The User-Selected radio button is automatically activated 
when you select a Black Oil method that is not the default.

 Figure 1.10

Refer to Appendix A - 
Neotec Black Oil 
Methods for more 
information on the black 
oil methods available and 
other terminology.

You can restore the 
default settings by 
clicking on the Black Oil 
Defaults radio button.

Close icon
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displays the Black Oil Fluid Package and shows the number 
of components (NC) and property package (PP). The newly 
created Black Oil Fluid Package is assigned by default to the 
main flowsheet. Now that the Simulation Basis is defined, 
you can install streams and operations in the Main 
Simulation environment.

9. To leave the Basis environment and enter the Simulation 
environment, do one of the following:

• Click the Enter Simulation Environment button on the 
Simulation Basis Manager view.

• Click the Enter Simulation Environment icon on the 
tool bar.

1.3.3 Entering the Simulation 
Environment

When you enter the Simulation environment, the initial view 
that appears depends on your current Session Preferences 
setting for the Initial Build Home View. Three initial views are 
available: 

• PFD
• Workbook
• Summary

Enter Simulation 
Environment icon
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1-14 Setting the Simulation Basis
Any or all of these can be displayed at any time; however, when 
you first enter the Simulation environment, only one appears. In 
this example, the initial Home View is the PFD (HYSYS default 
setting).

There are several things to note about the Main Simulation 
environment. In the upper right corner, the Environment has 
changed from Basis to Case (Main). A number of new items are 
now available in the menu bar and tool bar, and the PFD and 
Object Palette are open on the Desktop. 

 Figure 1.11
1-14



Black Oil 1-15
The PFD and Object Palette are described below.

Before proceeding any further, save your case.

1. Do one of the following:
• From the File menu, select Save.
• Press CTRL S.
• Click the Save icon on the tool bar.
If this is the first time you have saved your case, the Save 
Simulation Case As view appears. 

By default, the File Path is the Cases sub-directory in your 
HYSYS directory.

Objects  Description

PFD The PFD is a graphical representation of the flowsheet 
topology for a simulation case. The PFD view shows 
operations and streams and the connections between the 
objects. You can also attach information tables or 
annotations to the PFD. By default, the view has a single 
tab. If required, you can add additional PFD pages to the 
view to focus in on the different areas of interest.

Object 
Palette 

A floating palette of buttons that can be used to add 
streams and unit operations.
You can toggle the palette open or closed by pressing F4, 
or by selecting the Open/Close Object Palette command 
from the Flowsheet menu.

 Figure 1.12

You can also open the 
Object Palette by clicking 
the Object Palette icon in 
the PFD tool bar.

Save icon

When you choose to 
open an existing case 
by clicking the

Open Case icon , 
or by selecting Open 
Case from the File 
menu, a view similar to 
the one shown in 
Figure 1.12 appears. 
The File Filter drop-
down list will then allow 
you to retrieve backup 
(*.bk*) and HYSIM 
(*.sim) files in addition 
to standard HYSYS 
(*.hsc) files.
1-15



1-16 Building the Simulation
2. In the File Name cell, type a name for the case, for example 
BlackOil. 

You do not have to enter the *.hsc extension, HYSYS 
automatically adds it for you.

3. Once you have entered a file name, press the ENTER key or 
click the Save button. 

HYSYS saves the case under the name you have given it 
when you save in the future. The Save As view will not 
appear again unless you choose to give it a new name using 
the Save As command. If you enter a name that already 
exists in the current directory, HYSYS will ask you for 
confirmation before over-writing the existing file.

1.4 Building the 
Simulation

1.4.1 Installing the Black Oil 
Feed Streams

In this tutorial, you will install two black oil feed streams. 

1. To add the first black oil stream to your simulation do one of 
the following:
• From the Flowsheet menu, select Add Stream.
• You can also add a new material stream by pressing the 

F11 hot key.
• From the Flowsheet menu, select Palette. The Object 

Palette appears.
Double-click on the Material Stream icon. 

Material Stream icon
1-16
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The Black Oil Stream property view appears.

HYSYS displays three different phases in a black oil stream. 
The three phases are:

• Gas
• Oil
• Water
The first column is the overall stream properties column. You 
can view and edit the Gas, Oil, and Water phase properties 
by expanding the width of the default Black Oil stream 
property view. 

 Figure 1.13

You can also use the 
horizontal scroll bar to 
view all the phase 
properties.
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The expanded stream property view is shown below.

2. Rename the stream to Feed 1 by typing the new stream 
name in the Stream Name cell of the Overall column (first 
column).

Next you will define the gas composition in Feed 1.

 Figure 1.14

You can only rename the overall column, and that name 
appears on the PFD as the name for that black oil stream. 
You cannot change the phase name for the stream.
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3. On the Worksheet tab, click on the Gas Composition page 
to begin the compositional input for the stream. 

4. Check the Activate Gas Composition checkbox to activate 
the Gas Composition table.

5. Click on the Edit button. The Input Composition for Stream 
view appears. By default, you can only specify the stream 
compositions in mole fraction.

 Figure 1.15

 Figure 1.16

The Activate Gas 
Composition checkbox 
allows you to specify the 
compositions for each 
base component you 
selected in the Simulation 
Basis manager. After you 
have defined the gas 
composition for the black 
oil stream, HYSYS will 
automatically calculate 
the specific gravity for the 
gas phase. If gas 
composition information 
is not available, you can 
provide only the specific 
gas gravity on the 
Conditions page to define 
the black oil stream.
1-19



1-20 Building the Simulation
6. Enter the following composition for each component:

7. Click the Normalize button to ensure that the mole fraction 
sum equals 1.0.

8. Click the OK button, and HYSYS accepts the composition.

9. Click on the Conditions page on the Worksheet tab. 

Next you will define the conditions for Feed 1.

10. In the overall column (first column), specify the following 
conditions:

Component Mole Fraction

Methane 0.3333

Ethane 0.2667

Propane 0.1333

i-Butane 0.2000

n-Butane 0.0677

i-Pentane 0.0000

n-Pentane 0.0000

n-Hexane 0.0000

 Figure 1.17

In this cell... Enter...

Temperature (°C) 50
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HYSYS automatically assigns the same temperature and 
pressure to the Gas, Oil, and Water phases.

11.Specify the Specific Gravity for the Oil phase and Water 
phase to 0.847 SG_60/60 api and 1.002 SG_60/60 api, 
respectively.

Next you will specify the bulk properties for Feed 1. 

12. In the Bulk Properties group, specify a Gas Oil Ratio (GOR) 
of 1684 SCF/bbl, and Water Cut of 15%.

The Gas Oil Ratio is the ratio of the gas volumetric flow to oil 
volumetric flow at stock tank conditions. The Gas Oil Ratio 
will be automatically calculated if the volumetric flows of the 
gas, oil, and water phases are known. In this tutorial, the 
volumetric flowrates for the three phases are calculated by 
the Gas Oil Ratio and Water Cut.

The water content in the Black Oil stream can be expressed 
in two ways:

• Water Cut. The water cut is expressed as a percentage.

where:  

Vwater = volume of water

Voil = volume of oil

Pressure (kPa) 101.3

Volumetric Flow (barrel/day) 4500

 Figure 1.18

(1.1)

In this cell... Enter...

Water Cut
Vwater

Voil Vwater+
-------------------------------=
1-21



1-22 Building the Simulation
• WOR. A ratio of volume of water to the volume of oil.

You can select your water content input preference from the 
drop-down list.

Next you will specify a method for calculating the dead oil 
viscosity.

13.Click on the Viscosity Mtd button. The Black Oil Viscosity 
Method Selection view appears.

You can select the calculation methods from the Method 
Options drop-down list. Neotec recommends the user to 
enter two or more viscosity data points. In the event that 
only one data point is known, this is also an improvement 
over relying on a generalized viscosity prediction.

14.Click on the Method Options drop-down list and select 
Twu.

15.Close the Black Oil Viscosity Method Selection view.

(1.2)

 Figure 1.19

WOR
Vwater
Voil

---------------=

Displays the current 
selection of the Dead Oil 
Viscosity Equation. You 
can change this equation 
in the Neotec Black Oil 
Methods Manager. Refer 
to Dead Oil Viscosity 
Equation in Appendix 
A.1 - Neotec Black Oil 
Methods and 
Thermodynamics for 
more information.
1-22



Black Oil 1-23
Now Feed 1 is fully defined.

The Surface Tension and Watson K are automatically 
calculated by HYSYS as specified in the Neotec Black Oil 
Methods Manager. You can view the property correlations for 
each phase by clicking on the Properties page where you 
can add and delete correlations as desired.

 Figure 1.20

 Figure 1.21
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1-24 Building the Simulation
16.Create a second black oil feed stream, Feed 2 and define it 
with the following data:

In these cells... Enter...

Conditions Page

Temperature (°F), Overall 149

Pressure (psia), Overall 29.01

Volumetric Flow (barrel/day), 
Overall

6800

Specific Gravity (SG_60/60 api) Oil: 0.8487
Water: 1.002

Gas Oil Ratio 1404 SCF/bbl

Water Cut 1.5

Viscosity Method Options Beggs and Robinson

Gas Composition Page

Methane 1.0

 Figure 1.22
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1.4.2 Installing Unit 
Operations

HYSYS unit operations typically solve to equilibrium conditions 
using an equation of state or activity model. With the HYSYS 
Upstream Option, HYSYS unit operations will solve in black oil 
mode and be able to blend different black oils together.

Now you have fully defined two black oil feed streams. The next 
step is to install the necessary unit operations for the blending 
and transitioning process.

Installing the Valve
The first operation that will be installed is a Valve, used to 
decrease the pressure of Feed 1 before it is blended with Feed 2.

1. Double-click on the Valve icon in the Object Palette. The 
Valve property view appears.

2. On the Connections page, open the Inlet drop-down list by 
clicking the down arrow icon .  

The Worksheet tab of some HYSYS unit operation property 
views are not supported when the unit operations are used 
in Black Oil mode.

 Figure 1.23

The following unit 
operations can support 
black oil streams:

• Valve
• Mixer
• Pump
• Recycle
• Separator
• Pipe Segment
• Heat Exchanger
• Expander
• Compressor
• Heater
• Cooler

Valve icon
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3. Select Feed 1 from the list. 

Alternatively, you can make the connections by typing the 
exact stream name in the cell, then pressing ENTER.

4. Move to the Outlet field by clicking on it. Type ValveOut in 
the Outlet cell and press ENTER.

The status indicator displays Unknown Delta P. To specify a 
pressure drop for the Valve:

5. Click on the Parameters page.

6. Specify 5 kPa in the Delta P field.

Now the status indicator has changed to green OK, showing that 
the valve operation and attached streams are completely 
calculated.

Installing the Mixer
The second operation that will be installed is a Mixer, used to 
blend the two black oil feed streams.

To install the Mixer:

1. Double-click on the Mixer icon in the Object Palette. The 
Mixer property view appears.

2. Click the <<Stream>> cell to ensure the Inlets table is 
active.

 Figure 1.24
Mixer icon
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The status bar at the bottom of the view shows that the 
operation requires a feed stream.

3. Open the <<Stream>> drop-down list of feeds by clicking 
the down arrow icon, or by pressing F2 and then the DOWN 
arrow key.  

4. Select ValveOut from the list. The stream is transferred to 
the list of Inlets, and <<Stream>> is automatically moved 
down to a new empty cell.

5. Repeat steps 3-4 to connect the other stream, Feed 2.

The status indicator now displays Requires a product 
stream. Next you will assign a product stream.

6. Move to the Outlet field by clicking on it, or by pressing 
TAB.

7. Type MixerOut in the cell, then press ENTER. 

HYSYS recognizes that there is no existing stream named 
MixerOut, so it will create the new stream with this name.

 Figure 1.25

Down arrow icon

Alternatively, you can 
make the connections by 
typing the exact stream 
name in the cell, then 
pressing ENTER.
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The status indicator now displays a green OK, indicating that 
the operation and attached streams are completely 
calculated. 

8. Click the Parameters page. 

9. In the Automatic Pressure Assignment group, leave the 
default setting at Set Outlet to Lowest Inlet.

 Figure 1.26

 Figure 1.27

HYSYS has calculated the 
outlet stream by 
combining the two inlets 
and flashing the mixture 
at the lowest pressure of 
the inlet streams. In this 
case, ValveOut has a 
pressure of 96.3 kPa and 
Feed 2 has a pressure of 
200 kPa. Thus, the outlet 
from the Mixer has a 
pressure of 96.3 kPa (the 
lowest pressure between 
the two inlets).

Refer to Appendix A - 
Neotec Black Oil 
Methods, for more 
information on the 
specific gravity and 
viscosity of heavy oil/
condensate blends.
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Installing the Black Oil Translator
Next you will install a Black Oil Translator to transfer the black 
oil stream data into a compositional stream so that you can 
analyze the properties of the blended black oil stream from the 
Mixer. The Black Oil Translator is implemented in HYSYS using 
the Stream Cutter operation and a custom Black Oil Transition. 
The Black Oil Translator interacts with an existing Stream Cutter 
unit operation to convert the Black Oil stream into a 
compositional material stream.

Adding Non-Black Oil Stream

Before you install the Black Oil Translator, you need to install a 
non-black oil stream for the Black Oil Translator outlet stream. 
Thus, you will need to add a new fluid package and assign it to 
the outlet stream.

To add a new fluid package:

1. Click on the Enter Basis Environment icon in the tool bar. 
The Simulation Basis Manager appears.

2. Click on the Fluid Pkgs tab.

3. Click Add. 

4. Select Peng-Robinson from the property package list in the 
Property Package Selection group.

Enter Basis Environment 
icon
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5. In the Name field, rename the fluid package to PR as shown 
below.

6. Close the Fluid Package view.

7. Click on the Return to Simulation Environment button in 
Simulation Basis Manger.

8. To add the Black Oil Translator outlet stream, do one of the 
following:

• From the Flowsheet menu, select Add Stream.
• Press F11.
• From the Object Palette, double-click on the Material 

Stream icon. 
9. In the stream property view, click the Worksheet tab and 

select the Conditions page.

10. In the Stream Name cell type Outlet.

11. In the Fluid Package cell, select PR from the drop-down 
list.

 Figure 1.28

Material Stream icon
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Once you selected PR as the fluid package, the Outlet 
stream property view is automatically changed to a HYSYS 
compositional stream. 

12.Close the Outlet property view.

Adding the Black Oil Translator
There are two ways that you can add the Black Oil Translator to 
your simulation:

1. From the Flowsheet menu, select Add Operation. The 
UnitOps view appears.

2. In the Categories group, select the All Unit Ops radio 
button.

3. From the Available Unit Operation lists, select Black Oil 
Translator.

4. Click Add.

OR

 Figure 1.29

You can also open the 
UnitOps view by pressing 
the F12 hot key.
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1. From the Object Palette, click on the Upstream Ops icon.
The Upstream Ops Palette appears.

2. Double-click the Black Oil Translator icon. 

The Black Oil Translator property view appears.

In certain situations, the Black Oil Translator will automatically 
be added to the flowsheet. This occurs when the stream 
connections are made to operations that have streams with 
different fluid packages connected or the operation itself is set 
to use a different fluid package. The Stream Cutter dictates the 
rules for when the Black Oil Translator is automatically added.

To delete the Black Oil Translator operation, click the Delete 
button. HYSYS will ask you to confirm the deletion.

To ignore the Black Oil Translator operation during calculations, 

 Figure 1.30

 Figure 1.31

Upstream Ops icon

Black Oil Translator icon

You can also delete a 
Black Oil Translator by 
clicking on the Black 
Oil Translator icon on 
the PFD and pressing 
the DELETE key.
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activate the Ignored checkbox. HYSYS completely disregards 
the operation (not calculate the outlet stream) until you restore 
it to an active state by deactivating the checkbox.

Defining the Black Oil Translator

To complete the Connections page:

1. Open the Inlet drop-down list by clicking the down arrow 
icon, or by pressing the F2 key and then the DOWN arrow 
key.

2. Select MixerOut as the inlet.

3. Move to the Outlet field by clicking on it.

4. Select Outlet as the outlet stream.

Once the outlet stream is connected, the Black Oil Translator 
starts transitioning the black oil data to the Outlet stream 
using the HYSYS default transition setting.

The solving status is indicated in the Object Status Window. 
As the Black Oil Translator is solving, a list of 
hypocomponents are generated in the Outlet stream to 
characterize a black oil stream from a compositional stream 
perspective. You can view each hypocomponent created in 
the Trace Window as the Black Oil Translator is solving.

 Figure 1.32

Down arrow icon
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5. Click on the Transition tab.

• The Transition Type group displays the transition type (in 
this case: BlackOil Transition) available for this Black 
Oil Translator operation.

• The Current Transition group contains all the options 
used to configure the Black Oil Transition method.

The composition of MixerOut is copied to the composition 
table as shown in the figure above. Leave the composition as 
default.

6. In the Black Oil Transition Method group, confirm that the 
Three Phase radio button is selected.

7. Save the case.

If the Outlet stream had Black Oil as the fluid package, the 
following warning message view would appear.

 Figure 1.33

Refer to Appendix B - 
Black Oil Transition 
Methods for more 
information on the 
Simple, Three Phase, and 
Infochem Multiflash 
transition method.
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1.4.3 Results
When the solving is completed, the status indicator for the 
Outlet stream and Black Oil Translator should be changed to a 
green OK, showing that both operations are completely defined.

1. In the Outlet stream property view, click on the 
Compositions page on the Worksheet tab.

2. In the component composition list, you can view the 
composition for all the hypocomponents created as well as 
the composition for C1 to C6.

3. Close the Outlet stream property view.

4. Double-click on the CUT-100 operation on the PFD. The 
black oil translator property view appears.

5. Click on the Worksheet tab.

On the Conditions page, the Compositional stream 
properties and conditions for the black oil stream MixerOut 
are displayed in the Outlet column. 

 Figure 1.34

CUT-100 operation
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You can examine and review the results for the MixerOut 
stream as a compositional stream.

 Figure 1.35

 Figure 1.36
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1.5 Dynamic Simulation
In this tutorial, the black oil dynamic capability will be 
incorporated into a steady-state black oil translation simulation 
case. 

You can continue into this dynamic section with the black oil 
translation case that you built during the steady state section.

1. Open the BlackOil.hsc case (if it is not already open in the 
HYSYS).

2. Save the case under the new name: BlackOilDyn.hsc.

1.5.1 Modifying the Steady 
State Flowsheet

Before the case can be run in Dynamic mode, it is necessary to 
modify the steady-state model so that a pressure-flow relation 
exists between each unit operation.

In order to realistically model flow behaviour in a dynamic 
simulation case, you will change the Mixer to equalize all inlet 
pressures so that the flow to and from the Mixer is determined 
by the pressure-flow network:

1. Delete the specified pressure in Feed 2.
2. Double-click on the Mixer. The Mixer property view appears.

3. Click on the Dynamics tab, and select the Specs page.

4. In the Pressure Specification group, select the Equalize All 
radio button. 

HYSYS automatically recalculates and solves the Mixer 
operation. The status indicator of the Mixer has now changed 
to a green OK. The flowsheet is completely defined.

 Figure 1.37

You can also equalize the 
inlets pressures for the 
Mixer by selecting the 
Equalize All radio button 
on the Parameters page 
on the Design tab.
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1.5.2 Setting Pressure-Flow 
Specifications

In Dynamic mode, the degrees of freedom for the flowsheet 
must be zero. You can reduce the degrees of freedom by setting 
the pressure-flow specifications in each boundary stream:

1. Double-click on Feed 1. The stream property view appears.
2. Click on the Dynamics tab, and select the Specs page.

3. Ensure the Pressure specification is active with a check in 
Active checkbox, and deactivate the Volumetric Flow 
specification.

 Figure 1.38
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4. For Feed 2, specify the Specs page as shown:

5. For Outlet, specify the pressure-flow specifications as 
shown:

6. Save the case. The simulation case is ready to run in 
Dynamic mode.

 Figure 1.39

 Figure 1.40
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7. Click the Integrator Holding icon (red) on the Tools bar to 
hold all calculations.

8. Click the Dynamics Mode icon on the Tools bar.

9. A view appears asking you to confirm switching the 
simulation case to Dynamics mode. Click Yes.

If the Dynamics Assistant is active, HYSYS will ask you 
whether you want to make certain changes to the simulation 
case in the Dynamic Assistant before engaging in dynamic 
mode. Click No to the Dynamic Assistant.

The Dynamics Assistant makes recommendations as to 
how the flowsheet topology should change and what 
pressure-flow specifications are required in order to run the 
case in dynamic mode. However, in this tutorial some of 
these changes have been made manually as you modified 
the flowsheet, and the remaining changes are not necessary 
for the purpose of this example. 

10.Start the Integrator by clicking the Integrator Active icon 
in the toolbar.

The simulation case is now running in Dynamic mode. The 
integration time and status are indicated in the Trace Window 
and Status Bar.

The Dynamic Assistant is one of the methods for preparing a 
steady state case for dynamic mode. You can set your own 
pressure-flow specifications and size the unit operations 
manually on their Specs page on the Dynamics tab.

Integrator Holding icon 
(red)

Dynamic Mode icon

Integrator Active icon 
(green)
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1.5.3 Monitoring in Dynamics
In Dynamic mode it is difficult to observe the behaviour of 
simulation variables as they vary with time. Stripchart allows 
you to monitor various variable sets of interest as they are 
constantly updated in real time. You will create a strip chart to 
monitor the temperature, pressure, and flow for the Outlet:

1. Set the Integrator to holding mode by clicking the 
Integrator Holding icon.

2. Double-click on the Outlet stream.

3. Click on the Dynamics tab, and select the Stripchart page.

4. From the Variable Set drop-down list, select the T, P, and 
F variables set.

5. Display the strip chart by clicking the Create Stripchart 
button. A strip chart view appears.

6. Activate the Integrator by clicking the Integrator Active 
icon in the toolbar.

As the Integrator is running, you should see the 
temperature, pressure, and flow of the Outlet updating.

 Figure 1.41

Integrator Holding icon 
(red)

Integrator Active icon 
(green)
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1.5.4 Notes
The following should be noted when using black oil in Dynamic 
mode:

• Black oil system does not support Component Splitter 
and tray section since they are strongly linked to 
composition.

• In steady-state black oil translation, the component list 
changes after the black oil stream is converted to a 
compositional stream. However for black oil translation in 
dynamic mode, a new composition using the existing 
component list is calculated. Ensure that the desired 
components are already present on the non-black oil side 
of the transition before the simulation starts. The 
simplest way to do this is to use the component list from 
a steady-state result.

• Always refer to the stream property view for the black oil 
simulation information.

• To obtain the most accurate black oil results, avoid using 
black oil system with extreme simulation conditions or 
phase ratios.
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A.1 Neotec Black Oil 
Methods and 
Thermodynamics

You can select the desired black oil methods in the Neotec Black 
Oil Methods Manager.

Several black oil PVT calculation methods exist, each based on 
data from a relatively specific producing area of the world.

Correlations Data

Standing (1947) Correlation 
for Rs and Bo 

Based on 22 California crude oil-gas 
systems. 

Lasater (1958) Correlation 
for Rs 

Developed using 158 data from 137 
crude-oils from Canada, Western and 
mid-continent USA, and South America.

Vasquez and Beggs (1977) 
Correlations for Rs and Bo 

Based on 6004 data. Developed using 
data from Mid-West and California crudes.

Glaso (1980) Correlations 
for Rs and Bo 

For volatile and non-volatile oils. 
Developed using data from North Sea 
crudes. 

Al-Marhoun (1985, 1988, 
1992) Correlations for Rs 
and Bo 

Based on data from Saudi crude oils and 
Middle East reservoirs. 

Abdul-Majeed and Salman 
(1988) Correlation for Bo 

Based on 420 data points from 119 crude 
oil-gas systems, primarily from Middle 
East reservoirs.

Dokla and Osman (1992) 
Correlations for Rs and Bo 

Based on 51 bottomhole samples taken 
from UAE reservoirs. 

Petrosky and Farshad (1993) 
Correlations for Rs and Bo 

Based on 81 oil samples from reservoirs 
in the Gulf of Mexico.
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A.1.1 Terminology
Before we discuss the PVT behaviour and transport property 
procedures, you should be familiar with the following terms:

• Stock Tank Conditions
• Produced Gas Oil Ratio
• Solution Gas Oil Ratio
• Viscosity of Heavy Oil/Condensate Blends
• Specific Enthalpies for Gases and Liquids
• Oil-Water Emulsions

Stock Tank Conditions
Stock tank conditions are the basic reference conditions at 
which the properties of different hydrocarbon systems can be 
compared on a consistent basis. The stock tank conditions are 
defined as 14.70 psia (101.325 kPa) and 60°F (15°C).

Produced Gas Oil Ratio
The produced gas oil ratio is the total amount of gas that is 
produced from the reservoir with one stock tank volume of oil. 
Typical units are scf/stb or m3 at s.c./m3 at s.c.

Solution Gas Oil Ratio
The solution gas/oil ratio is the amount of gas that saturates in 
the oil at a given pressure and temperature. Typical units are 
scf/stb or m3at s.c./m3 at s.c.

Above the bubble point pressure, for a given temperature, the 
solution gas/oil ratio is equal to the produced gas oil ratio. For 
stock tank oil (i.e., oil at stock tank conditions) the solution gas 
oil ratio is considered to be zero.
A-3
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Viscosity of Heavy Oil/Condensate 
Blends
A common relationship for estimating the viscosity of a mixture 
of two hydrocarbon liquids is as follows:

where:  

µm= viscosity of the blended stream

µA = viscosity of liquid A

µB = viscosity of liquid B

CA= volume fraction of liquid A in the blended stream

For cases where , it is recommended by Shu (1984) that 
another correlation should be used to calculate the viscosity of 
the mixture assuming that liquid A is the heavier and more 
viscous fluid than liquid B.

where:

SA = specific gravity of liquid A

SB = specific gravity of liquid B

(A.1)

(A.2)

(A.3)

(A.4)

µm µA
CA µB

1 CA–( )
×=

µA
µB
------ 20>

µm µA
XA µB

1 XA–( )
×=

XA
αCA

αCA CB+
------------------------=

α
17.04 SA SB–( )0.5237SA

3.2745SB
1.6316

Ln
µA
µB
------ 
 

----------------------------------------------------------------------------------=
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Data from two different crude oil/condensate blends have been 
used to compare the results predicted by Equation (A.1) and 
Equation (A.2) through Equation (A.4). The following table 
contains the available data for the two oils and the condensate 
liquid.

To simplify viscosity calculations at intermediate temperatures, 
the data given in the above table for each liquid were fitted to 
the following form:

where:  

T = temperature, °C

a, b = fitted constants

The resulting values of a and b are given in the following table.

In all cases, the fit is very accurate (maximum error is about 
3.6%) and the use of Equation (A.5) introduces minimal error 
into the comparison.

Liquid
API 
Gravity

Specific 
Gravity

Viscosity (mPa.s)

5°C 10°C 20°C

Oil A 14.3 0.970 12840 7400 2736

Oil B 14.3 0.964 3725 2350 1000

Condensate 82.1 0.662 0.42 0.385 -

(A.5)

Liquid a b

Oil A 849.0 3.07

Oil B 370.0 2.62

Condensate 0.28 0.44

µ a 100
1.8 T 32+⋅
--------------------------- 
 ⋅

b
=
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Measured data were available at three temperatures (0°C, 5°C, 
and 10°C) for each of the crude oils with three blending ratios 
(90%, 80%, and 70% crude oil). Mixture viscosities calculated 
by Equation (A.1) and Equation (A.2) are compared with 
these data in the following table.

From the table it is clear that the results calculated using 
Equation (A.1) are not acceptable and would lead to gross 
errors calculated pressure losses. As for Equation (A.2), it 
gives excellent results for the blends involving Oil A. While the 
errors associated with Oil B blends are significantly larger, they 
are not unreasonable.

Oil
Temp

(°C)

Blend

(% crude)

µmeas

(mPa.s)

Equation 1.3 Equation 1.4

µcalc

(mPa.s)
error 
(%)

µcalc

(mPa.s)
error 
(%)

A 0 90 2220 9348 321.1 2392 7.8

A 0 80 382 3111 714.4 370 -3.1

A 0 70 89 1035 1062.9 86 -3.4

A 5 90 1464 4661 218.4 1442 -1.5

A 5 80 272 1656 508.2 260 -4.4

A 5 70 71 588 728.2 66 -7.0

A 10 90 976 2670 173.6 953 -2.4

A 10 80 198 999 404.6 194 -2.0

A 10 70 56 374 567.9 53 -5.4

B 0 90 744 2774 272.9 989 32.9

B 0 80 147 1056 618.4 205 39.5

B 0 70 45 402 793.3 58 28.9

B 5 90 516 1531 196.7 629 21.9

B 5 80 112 615 449.1 148 32.1

B 5 70 37 247 567.6 45 21.6

B 10 90 396 951 140.2 436 10.1

B 10 80 87 399 358.6 113 29.9

B 10 70 29 168 479.3 37 27.6
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Equation (A.3) can be further modified to improve its accuracy 
by introducing a proprietary calibration factor.

The results obtained from the modified Shu correlation show 
that the calibration procedure has yielded a significant 
improvement in accuracy. This also applies to data at 0°C, 
which were not used in the determination of the calibration since 
no measured viscosity values for either Oil B or the condensate 
were available at that temperature.

It has been demonstrated that the correlation of Shu (1984) is 
much superior to the simple blending relationship expressed by 
Equation (A.1), and it is capable of giving acceptable accuracy 
for most pipeline pressure drop calculations.

Specific Enthalpies for Gases and 
Liquids
The temperature profiles are calculated by simultaneously 
solving the mechanical and total energy balance equations. The 
latter includes a term that is directly related to changes in the 
total enthalpy of the fluid(s). This means that all Joule-
Thompson expansion cooling effects for gases, and frictional 
heating effects for liquids would be taken into account implicitly. 
It is not necessary, for example, to impose the approximations 
inherent in specifying a constant average value of a Joule-
Thompson coefficient. it is, however, necessary to be able to 
compute the specific enthalpy of any gas or liquid phase, at any 

Oil
Temp

(°C)

Blend

(% crude)

µmeas

(mPa.s)

Equation 1.4

µcalc

(mPa.s)

error

(%)

B 0 90 744 817 9.8

B 0 80 147 157 6.8

B 0 70 45 43 -4.4

B 5 90 516 529 2.5

B 5 80 112 115 2.7

B 5 70 37 34 -8.1

B 10 90 396 371 -6.3

B 10 80 87 90 3.4

B 10 70 29 28 -3.4

In pipelines and wells the 
Joule-Thompson effect is 
typically exhibited as a 
large decrease in 
temperature as a gas 
expands across a 
restriction. According to 
the relationships between 
the temperature, 
pressure, and latent 
energy of the fluid, the 
fluid typically cools when 
it expands, and warms 
when compressed.
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pressure and temperature, as accurately as possible. The 
following sections describe the procedures for computing this 
important thermodynamic parameter for various fluid systems.

Undefined Gases
For undefined single phase gases, where only the gravity is 
known, the specific enthalpy is determined by assuming the gas 
to be a binary mixture of the first two normal hydrocarbon gases 
whose gravities span that of the unknown gas. The mole 
fractions are selected such that the gravity of the binary mixture 
is identical to that of the unknown gas of interest.

For example, a natural gas having a gravity of 0.688 would be 
characterized as a binary mixture consisting of 72.3 mole % 
methane (gravity = 0.5539) and 27.7 mole % ethane (gravity = 
1.0382) since (0.723)(0.5539) + (0.277)(1.0382) = 0.688. The 
enthalpy of the binary mixture, calculated as described above 
for compositional systems, is then taken as the enthalpy of the 
gas of interest. This is in fact the same procedure that has been 
used to create the generalized specific enthalpy charts that 
appear in the GPSA Engineering Data Book (1987).

The specific enthalpy has been evaluated as described above for 
a number of specified gas gravities over a relatively wide range 
of pressures and temperatures. The enthalpy of the unknown 
gas is obtained at any given pressure and temperature by 
interpolation within the resulting matrix of values.
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Undefined Liquids

Undefined hydrocarbon liquids are characterized only by a 
specific or API gravity, and possibly also the Watson K factor. 
They are also referred to as “black oils”, and the specific 
enthalpy is computed using the specific heat capacity calculated 
using the correlation of Watson and Nelson (1933):

where:  

Cp = specific heat capacity of the oil, btu/lb°F

T = temperature, °F

The three coefficients have the following equations:

where:  

K = Watson K factor = 

So = specific gravity of the oil

The specific enthalpy at any temperature T, relative to some 
reference temperature To, is given by the following equation:

The specific enthalpy computed using Equation (A.8) is 
independent of pressure. For real liquids, the effect of pressure 
is relatively small compared to the temperature effect, but it 
may become significant when the pressure gradient is large due 
to flow rate rather than elevation effects.

(A.6)

(A.7)

(A.8)

Cp A1 A2 A3T( )+[ ]×=

A1 0.055K 0.35+=

A2 0.6811 0.308γo–=

A3 0.000815 0.000306γo–=

TB
1 3⁄

So
-----------

H Cp T( ) Td
To

T

∫=
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Large pressure gradients tend to occur with high viscosity oils. 
At higher flow rates, frictional heating effects can become 
significant, and the heating tends to reduce the oil viscosity, 
which in turn, affects the pressure gradient. Unfortunately, this 
complex interaction cannot be predicted mathematically using 
specific enthalpy values that are independent of pressure. The 
net result is that the predicted pressure gradient will be higher 
than should actually be expected.

For fully compositional systems, the calculated specific enthalpy 
of a liquid phase does include the effect of pressure. A series of 
calculations have been performed using the Peng-Robinson 
(1976) equation of state for a variety of hydrocarbon liquids, 
ranging from relatively light condensate liquids to relatively 
heavy crude oils. In each case, specific enthalpy was calculated 
over a wide range of pressures at a low, moderate, and high 
temperature. In the case of the condensate liquids, specific 
compositional analyses were used. For the heavier crude oils, 
the composition consisted of a number of pseudo-components, 
based on published boiling point assay data, as generated by 
Neotec's technical utility module HYPOS. In all cases, the effect 
of pressure was found to be constant and is well represented by 
the following relation:

where:  

HP,T = specific enthalpy at the specific pressure and 
temperature, btu/lb-°F

HPo,T = specific enthalpy computed with Equation (A.8)

P = pressure, psia

Figure A.1, Figure A.2, and Figure A.3 show the comparison 
between specific enthalpies calculated using the Peng Robinson 
equation of state and those computed using Equation (A.9) for 
16.5, 31.9, and 40.5° API oils, respectively. For comparison 
purposes, HPo,T was taken to be the value computed by the Peng 
Robinson equations of state at 15 psia.

(A.9)HP T, H
Po T,

0.0038 P 15–( )×+=
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Effect of Pressure on Specific Enthalpy for a 16.5° API Oil

Effect of Pressure on Specific Enthalpy for a 40.5° API Oil

 Figure A.1

 Figure A.2
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Effect of Pressure on Specific Enthalpy for a 31.9° API Oil

The effect of pressure is included in all specific enthalpy 
calculations, and therefore, in all temperature profile 
calculations, in a way that closely approximates similar 
calculations for fully compositional systems.

Oil-Water Emulsions
The rheological behaviour of emulsions may be non-Newtonian 
and is often very complex. Generalized methods for predicting 
transport properties are limited because of the wide variation in 
observed properties for apparently similar fluids. It is usually 
the case with non-Newtonian fluids that some laboratory data or 
other experimental observations are required to provide a basis 
for selecting or tuning transport property prediction methods.

Neotec assumed that an emulsion behaves as a pseudo-
homogeneous mixture of hydrocarbon liquid and water and may 
thus be treated as if it were a single liquid phase with 
appropriately defined transport properties.

 Figure A.3
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The volumetric flow rate of this assumed phase is the sum of the 
oil and water volumetric flow rates,

where:  

Qe = volumetric flow rate of emulsion, ft3/sec or m3/sec

Qo = volumetric flow rate of oil, ft3/sec or m3/sec

Qw = volumetric flow rate of water, ft3/sec or m3/sec

The water volume fraction in the emulsion, Cw, is thus given by,

Since the emulsion is assumed to be a pseudo-homogeneous 
mixture, the density is given by,

where:  

ρe = density of the emulsion, lb/ft3 or kg/m3

ρw = density of the water at flowing conditions, lb/ft3 or kg/
m3

ρo = density of the oil at flowing conditions, lb/ft3 or kg/m3

The effective viscosity of an emulsion depends on the properties 
of the oil, the properties of the water, and the relative amounts 
of each phase. For a water-in-oil emulsion (i.e. oil is the 
continuous phase), the effective viscosity of the emulsion can be 
much higher than that of the pure oil.

(A.10)

(A.11)

(A.12)

Qe Qo Qw+=

Cw
Qw

Qo Qw+
--------------------=

ρe ρwCw ρo 1 Cw–( )+=
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A commonly used relationship for estimating the viscosity of a 
water-in-oil emulsion is,

where:  

µe = viscosity of the emulsion, cP or mPa.s

µo = viscosity of the oil, cP or mPa.s

Fe = emulsion viscosity factor

The factor Fe is usually considered to be a function of the water 
fraction Cw and the best known procedure for estimating Fe is 
the graphical correlation of Woelflin (1942).

More recently, Smith and Arnold (see Bradley, 1987) 
recommended the use of the following simple quadratic 
equation,

The emulsion viscosity factors based on Woelflin’s ‘medium’ 
emulsion curve (he also presented curves for ‘loose’ and ‘tight’ 
emulsions) are compared in Figure A.4 with those calculated 
using Equation (A.14). 

(A.13)

(A.14)

µe Feµo=

Fe 1.0 2.5Cw 14.1Cw
2

+ +=
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The two relationships are virtually identical for Cw < 0.4, but 
diverge rapidly at higher values of Cw.

With increasing water fraction, the system will gradually behave 
more like water than oil. The water fraction at which the system 
changes from a water-in-oil emulsion to an oil-in-water 
emulsion is called the inversion point. The transition to an oil-in-
water emulsion is generally very abrupt and characterized by a 
marked decrease in the effective viscosity. The actual inversion 
point must usually be determined experimentally for a given 
system as there is no reliable way to predict it. In many cases 
however, it is observed to occur in mixtures consisting of 
between 50% and 70% water.

Guth and Simha (1936) proposed a similar correlation as Smith 
and Arnold (Equation (A.14)),

where:  

Fe = emulsion viscosity multiplier for the continuous phase 
viscosity

Cd = volume fraction of the dispersed phase

 Figure A.4

(A.15)Fe 1.0 2.5Cd 14.1Cd
2

+ +=
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If Cwi is defined as the water fraction at the inversion point, then 
for Cw < Cwi, the emulsion viscosity is given by Equation 
(A.13), with Fe defined by Equation (A.14). However, for Cw > 
Cwi, the emulsion viscosity should be computed using the 
following expression,

where:  

µw = viscosity of the water phase, cP or mPa.s

Fe = 1.0 + 2.5(1-Cw)+14.1(1-Cw)2

As shown in Equation (A.15), while the constant and the first 
order term on the right can be shown to have a theoretical 
basis, the squared term represents a purely empirical 
modification. It seems reasonable therefore to view the 
coefficient of the squared term (i.e., 14.1) as an adjustable 
parameter in cases where actual data are available.

To illustrate the predicted effect of the inversion point, Figure 
A.5 shows a case in which Cwi = 0.65. Also the corresponding 
curves for several different values of the coefficient of the 
squared term are compared.

(A.16)

 Figure A.5

µe Feµw=
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The large decrease in the predicted value of the emulsion 
viscosity is evident. The effect on the emulsion viscosity can be 
seen in Figure A.6, since, above the inversion point, the factor 
is used to multiply the water viscosity, which is typically 
significantly lower than the oil viscosity.

Limited experience to date in performing pressure loss 
calculations for emulsions suggests that the Woelflin correlation 
over-estimates the viscosity at higher water fractions. It is thus 
recommended that one use the Guth and Simha equation unless 
available data for a particular case suggest otherwise.

 Figure A.6
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A.1.2 PVT Behaviour and 
Transport Property 
Procedures

There are nine PVT behaviour and transport property procedures 
available in the Neotec Black Oil Methods Manger: 

• Solution GOR
• Oil FVF
• Undersaturated Oil FVF
• Gas Viscosity
• Live Oil Viscosity
• Undersaturated Oil Viscosity
• Dead Oil Viscosity Equation
• Watson K Factor
• Surface Tension 

Solution GOR
The solution gas oil ratio, Rs, is the amount of gas that is 
assumed to be dissolved in the oil at a given pressure and 
temperature. Typical units are scf/stb or m3 at s.c./m3 at s.c.

 Figure A.7
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Above the bubble point pressure, for a given temperature, the 
solution gas oil ratio is equal to the Produced Gas Oil Ratio. For 
the oil at Stock Tank Conditions, the solution gas oil ratio is 
considered to be zero.

You can select one of the following methods to calculate the 
solution GOR:

• Standing.
• Vasquez Beggs.
• Lasater.
• Glaso (Non Volatile Oils)
• Glaso (Volatile Oils)
• Al Marhoun (1985)
• Al Marhoun (Middle East Oils)
• Petrosky and Farshad
• Dolka and Osman

Oil FVF
The Oil Formation Volume Factor is the ratio of the liquid volume 
at stock tank conditions to that at reservoir conditions.

The formation volume factor (FVF, Bo) for a hydrocarbon liquid 
is the volume of one stock tank volume of that liquid plus its 
dissolved gas (if any), at a given pressure and temperature, 
relative to the volume of that liquid at stock tank conditions. 
Typical units are bbl/stb or m3/m3 at s.c.

You can select one of the following methods to calculate the Oil 
FVF:

• Standing
• Vasquez Beggs
• Glaso
• Al Marhoun (1985),
• Al Marhoun (Middle East OIls)
• Al Marhoun (1992)
• Abdul-Majeed and Salman
• Petrosky and Farshad
• Dolka and Osman
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Undersaturated Oil FVF
In HYSYS, the default calculation method is Vasquez Beggs. You 
can choose other calculation methods as follows:

• Al Marhoun (1992)
• Petrosky and Farshad

Figure A.8 shows the typical behaviour of the oil formation 
volume factor that is observed as the system pressure is 
increased at a constant temperature.

From the initial pressure up to the bubble point pressure (i.e., 
the point at which GOR = Rs, which happens to be 3,073 psia in 
this case), the oil is assumed to be saturated, and Bo continues 
to increase, as more and more gas goes into solution. The effect 
of this increasing solution gas is always much greater than the 
corresponding shrinkage of the oil due to pure compression 
effects. 

 Figure A.8
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At the bubble point, there is no more gas to go into the solution, 
and the oil then becomes progressively more undersaturated 
with increasing pressure. With the solution gas-oil ratio being 
constant, the portion of the curve in Figure A.8 labelled 
“Compressibility Ignored” shows the behaviour that would be 
predicted by the correlations for Bo that we have looked at to 
this point. In actual fact, however, at pressures greater than the 
bubble point pressure, Bo is decreasing, due totally to the 
compressibility of the oil. The actual behaviour that is observed 
is thus indicated in Figure A.8 by the portion of the curve 
labelled “Compressibility Included”. 

In general, the compressibility of liquids tends to be relatively 
low, and the pressure effect on Bo is thus not large. In this 
particular case, Bo decreases from 1.417 at the bubble point 
pressure to 1.389 at a pressure of 6,000 psia, which represents 
a volume decrease of only about 2% for a pressure increase of 
almost 50%. For some fluid systems, however, particularly 
lighter oils with relatively high GOR values, the effect can be 
significantly larger.

Gas Viscosity
Viscosity is a measure of resistance to flow of or through a 
medium. As a gas is heated, the molecules' movement increases 
and the probability that one gas molecule will interact with 
another increases. This translates into an increase in 
intermolecular activity and attractive forces. The viscosity of a 
gas is caused by a transfer of momentum between stationary 
and moving molecules. As temperature increases, molecules 
collide more often and transfer a greater amount of their 
momentum. This increases the viscosity.

You can select one of the following calculation methods to 
calculate the gas viscosity:

• Lee, Gonzalez and Eakin
• Carr, Kobayashi and Burrows (Dempsay version)
• Carr, Kobayashi and Burrows (Dranchuk version)
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Live Oil Viscosity
Live oil viscosity is the measure of flow resistance of the live oil. 
Live oil refers to oil that is in equilibrium with any gas that may 
be present. If there is any free gas, the oil is also said to be 
saturated. If there is no free gas, but more could go into 
solution in the oil if it were present, the oil is said to be 
undersaturated.

You can select one of the following calculation methods to 
calculate the live oil viscosity:

• Chew and Connally
• Beggs and Robinson
• Khan

Undersaturated Oil Viscosity
For a given temperature, an oil is said to be undersaturated at 
any pressure above the bubble point pressure. Increasing the 
pressure would force more gas to go into solution if there was 
any, but above the bubble point pressure, there is no more free 
gas. With no more gas going into solution above the bubble 
point, the viscosity of the oil actually begins to increase with 
increasing pressure due to the compressibility of the oil. Since 
liquid compressibility is typically small, the effect of pressure on 
viscosity is much smaller above the bubble point than below.

A number of correlations have been proposed for computing the 
viscosity of undersaturated oils, and a few of these are 
described below. All of these procedures assume that the bubble 
point pressure is known at the temperature of interest, as well 
as the saturated oil viscosity corresponding to the bubble point 
pressure.

You can select one of the following calculation methods to 
compute the undersaturated oil viscosity:

• Vasquez and Beggs
• Beal
• Khan
• Abdul and Majeed
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Dead Oil Viscosity Equation
The term Dead Oil refers to oil that has been taken to stock tank 
conditions and contains no dissolved gas (in other words, gas 
solution). Dead oil may exist at any pressure or temperature, 
but it is always assumed that all gas was removed at stock tank 
conditions. Any properties ascribed to a dead oil are thus 
characteristic of the oil itself.

Dead Oil Viscosity is the viscosity of an oil with no gas in 
solution. A number of the more useful methods for calculating 
this quantity are defined in the equations below.

The General Equation is defined as,

where:  

µdo = dead oil dynamic viscosity, cP

CEPT, SLP = constants for a given oil

T = oil temperature, °F

The ASTM Equation is defined as,

where:  

Z = νdo + 0.7

νdo = dead oil kinematic viscosity, cS

A, B = constants for a given oil

T = oil temperature, °F

(A.17)

(A.18)

µdo CEPT 100
T

--------- 
  SLP=

log10 log10Z( ) A Blog10 T 460+( )–=
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The kinematic viscosity, νdo is given by, 

where:  

ρo = density of the oil at the temperature of interest, 
expressed in g/cm3.

The Eyring Equation is given by,

where:  

A and B = constants for a given oil

Watson K Factor
You can choose to specify the Watson K Factor, or you can have 
HYSYS calculate the Watson K Factor. The default option is 
Specify.

The Watson K Factor is used to characterize crude oils and crude 
oil fractions. It is defined as,

where:  

K = Watson K factor

TTB = normal average boiling point for the crude oil or crude 
oil fraction, °R

SGo = specific gravity of the crude oil or crude oil fraction

(A.19)

(A.20)

(A.21)

νdo
µdo
ρo
--------=

νdo Aexp 1.8B
T 460+
------------------ 
 =

K
TB

1 3⁄

SGo
-----------=
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For example, a particular kerosene cut, obtained over the 
boiling point range 284 - 482 °F, has a specific gravity of 
0.7966. Then,

Values of K typically range from about 11.5 to 12.4, although 
both lower and higher values are observed. In the absence of a 
known value, K = 11.9 represents a reasonable estimate.

Surface Tension
Surface tension is the measure of attraction between the 
surface molecules of a liquid. In porous medium systems (i.e. oil 
reservoirs), surface tension is an important parameter in the 
estimation of recoverable reserves because of its effect on 
residual saturations. On the other hand, most correlations and 
models for predicting two phase flow phenomena in pipelines 
are relatively insensitive to surface tension, and one can 
generally use an average value for calculation purposes. 
Calculations for wells have a somewhat stronger dependence on 
surface tension, in that this property can be important in 
predicting bubble and droplet sizes (maximum stable droplet 
size increases as surface tension increases), which in turn, can 
significantly influence the calculated pressure drop. Even then, 
however, surface tension typically appears in the equations 
raised to only about the ¼ power.

You can choose to have the surface tension calculated by 
HYSYS, or you can specify the surface tension. The default 
option is Calculate.

(A.22)
K 0.5 284 482+( ) 460+[ ]1 3⁄

0.7966
-----------------------------------------------------------------

11.86

=

=
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B-2 Transition Methods
B.1Transition Methods
The Black Oil Transition is the engine that is used in translating 
between black oils and compositional models. There are two 
available methods for Black Oil Transition:

• Simple
• Three Phase

B.1.1 Simple Method
The Simple method is a set of black oil transitions that do not 
require any additional user input at the operation level. The 
Simple method can be used when transitioning between the 
types of streams described in the following sections.

Black Oil to Black Oil
If two different black oil fluid packages are available within a 
flowsheet, the Simple method can be used for the transitioning 
between them. In this case, you need to specify the viscosity 
method and any corresponding viscosity data (such as a 
viscosity curve if required for that particular method) on the 
outlet stream. The transferrable properties include 
Temperature, Pressure, Phase Mass Flow Rates, Watson K (if 

 Figure B.1
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necessary), Surface Tension (if necessary), Oil Gravity, Gas 
Gravity or Gas Composition, and Water Gravity.

Compositional to Black Oil
When using a traditional compositional fluid package and a black 
oil fluid package in the same flowsheet, it maybe desirable to 
set the inlet as the compositional stream and the outlet as the 
black oil stream. This way, the Simple method can be used. The 
Temperature, Pressure, Phase Mass Flow Rates, Watson K (if 
necessary), Surface Tension (if necessary), Oil Gravity, Gas 
Gravity or Gas Composition, and Water Gravity are all 
transferred to the outlet. 

Black Oil to Compositional
The Simple method can also be used to convert between black 
oil and compositional material streams. In this situation the 
Temperature, Pressure, and Overall Mass Flow Rate are 
transferred to the outlet compositional material stream from the 
black oil inlet stream. As such, the outlet stream must already 
have a defined composition. This feature is primarily useful in 
providing flowsheet continuity. For a more thorough form of 
transition the Three Phase method should be used.
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B.1.2 Three Phase Method
The Three Phase method of transition is used when thorough 
conversion from black oil to compositional transition is required. 
The Three Phase method independently characterizes the three 
phases of the black oil as compositional phases and then 
recombines the phases back into a single compositional stream.

Gas Phase
The black oil gas phase is converted to a compositional model by 
relying on user inputs. If the black oil inlet stream has a known 
gas phase composition it is used by the Black Oil Transition. The 
composition as displayed in Figure B.2 is referred to as the 
Operating Gas Composition. You can overwrite the Operating 
Gas Composition. If you do not modify the Operating Gas 
Composition it will automatically reflect any changes that occur 
to the inlet black oil stream gas composition. If you modify the 
Operating Gas Composition, any changes to the inlet stream 
black oil gas composition will not be propagated to the 
Operating Gas Composition.

 Figure B.2

The Normalize 
Composition button is 
useful when many 
components are 
available, but you want to 
specify compositions for 
only a few. When you 
enter the compositions, 
click the Normalize 
Composition button and 
HYSYS ensures the Total 
is 1.0, while also 
specifying any <empty> 
compositions as zero. If 
compositions are left as 
<empty>, HYSYS cannot 
perform the flash 
calculation on the stream.

Clears all compositions.Allows you to enter any value for fractional 
compositions and have HYSYS normalize 
the values such that the total equals to 1.
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Oil Phase
The Black Oil oil phase is transitioned to a compositional model 
using the HYSYS Oil Manager Bulk Properties Assay Definition 
methods. The transition passes on the oil phase standard 
density and oil phase Watson K to the Oil Manager and an 
appropriate assay and blend is created for the user. This 
functionality is automatically done by HYSYS and no additional 
user interaction is required.

You can use the Oil Phase Cut Options to adjust the light end 
and auto-characterize the hypocomponents into user specified 
light end components. You have the option to have the HYSYS 
Oil Manager perform an auto cut, or specify the appropriate 
number of cuts.

Water Phase
The black oil water phase is assumed to be pure water by the 
black oil transition.

After the transition models the three phases, it recombines 
them into the outlet stream and passes on Temperature, 
Pressure, and Overall Mass Flow Rate. At this point, the outlet 
stream will flash and in most cases three corresponding 
compositional phases will be calculated. The outlet Vapour 

 Figure B.3
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phase represents the inlet Gas phase, the Liquid phase 
represents the Oil phase, and the Aqueous phase represents the 
Water phase. The outlet stream's property package and the 
flash determine the existence of phases, the phase fractions, 
and the phase properties. In most cases these items will be very 
similar to the inlet black oil stream particularly when using a 
property package such as Peng-Robinson. Overall Mass balance 
between the inlet and outlet is assured.

B.1.3 Infochem Multiflash
Multiflash is an advanced software package for modeling the 
properties of gases, liquids and solids. It consists of a 
comprehensive library of thermodynamic and transport property 
models, a physical property databank, methods for 
characterising and matching the properties of petroleum fluids 
and multiphase flashes capable of handling any combination of 
phases.

Refer to Chapter 2 - Multiflash for HYSYS Upstream for 
more information on Infochem Multiflash.
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2-2 Introduction
2.1 Introduction
Multiflash is an advanced software package for modeling the 
properties of gases, liquids and solids. It consists of a 
comprehensive library of thermodynamic and transport property 
models, a physical property databank, methods for 
characterising and matching the properties of petroleum fluids 
and multiphase flashes capable of handling any combination of 
phases.

This chapter describes the use of Multiflash with HYSYS 
Upstream (a product of Aspen Technology Inc.). Multiflash is 
available as a property package in the COMThermo 
thermodynamics option. The use of the Multiflash GUI for 
Microsoft Windows is described in the User Guide for 
Multiflash for Windows which is supplied as a pdf file (in the 
Multiflash installation directory) and as online help.

2.1.1 Installing Multiflash
Multiflash for COMThermo is installed as part of the HYSYS 
Upstream. The installation instructions in the User Guide for 
Multiflash for Windows refer to the standalone version of 
Multiflash and do not apply to HYSYS Upstream.
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2.2 Multiflash Property 
Package

A Multiflash property package consists of a set of components 
and thermodynamic and transport property models for several 
phases. In HYSYS terminology it corresponds to a Fluid Package 
plus a set of components. You may create several different 
property packages with different components and/or models as 
required.

2.2.1 Adding a Multiflash 
Property Package

To add a Multiflash property package to a new case, you must 
start HYSYS.

1. From the File menu, select New and then Case.
The Simulation Basis Manager appears.  

 Figure 2.1
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2. Click on the Enter PVT Environment button. The PVT 
Environment Manager appears.

3. On the Engine Setup tab, click the Add button. A new PVT 
package (PVT-1) is added to the PVT package list.

4. From the Selected Engine list, select Infochem 
Multiflash.

The components for the property package must be selected 
within the Multiflash GUI, for more information refer to the 
section on Components. You cannot select the components 
within HYSYS.

 Figure 2.2

Refer to Chapter 8 - PVT 
Environment in the 
HYSYS Simulation 
Basis guide for more 
information on the PVT 
Environment Manager.
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5. Click the Launch Engine button to launch the Infochem 
Multiflash GUI.

Multiflash Flash 

The Multiflash flash is very reliable in most circumstances, 
including situations with multiple liquid phases and solids. The 
convergence tolerance is very tight and, therefore, it may take 
longer to converge than some other options but the result is 
correct. For simple vapour-liquid equilibrium calculations any 
flash method should be reliable.

 Figure 2.3

The Multiflash flash is capable of doing calculations for solid, 
liquid and gas phases but for HYSYS Upstream only the gas 
and liquid phases are used.
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HYSYS Flash 

If you are using the HYSYS flash and you want to change the 
flash settings, you can click the Advanced button on the HYSYS-
Multiflash Setup view, which opens the Fluid Package view.

When you click the Extended PropPkg Setup button, the 
Extended Property Package Setup view appears.

Clicking the Finish Setup button opens the Multiflash GUI. 

 Figure 2.4

 Figure 2.5

Refer to Section 2.2.2 - 
Configuring a Property 
Package for information 
on configuring the 
property package.
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2.2.2 Configuring a Property 
Package

The Multiflash Windows program (GUI) is used to configure a 
property package for HYSYS Upstream but it can also be used to 
carry out flash calculations, to plot phase envelopes or to 
regress model parameters to match experimental 
measurements. The use of the GUI is described in the User 
Guide for Multiflash for Windows. This section gives a brief 
description of how it is used with HYSYS and highlights extra 
features provided for the HYSYS setup.

To configure a Property Package it is necessary to specify the 
following information:

• The components (substances) that are included. These 
maybe any components from databanks supported by 
Multiflash or petroleum fraction pseudocomponents.

• The thermodynamic/physical property models that will 
be used to evaluate properties such as volume, enthalpy, 
fugacity coefficients, transport properties.

• The binary interaction parameters (BIPs) that will be 
used by the model(s).

• The phases which may be included.

Components
The Select/Components menu item allows you to specify the 
components in the property package. Components may be 
selected from a databank by clicking on a component name or 
typing the name of a component. Components in a databank 
may be searched for by name, part of a name or by formula as 
shown in the figure below.

Petroleum fraction pseudocomponents may be specified by 
entering properties such as molecular weight, specific gravity, 
and Multiflash will then estimate any other properties required.
2-7
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In addition there is an option to define a new component by 
entering in all the data.

Petroleum Fluid Characterisation
An alternative way of entering compositional information is to 
use the PVT Lab Input item on the Select menu. This displays a 
form that allows input of the typical information included in a 
PVT report produced by oil industry service companies. The 
representation of the fluid can be controlled by the user by 
selecting the number of pseudocomponents used to describe the 
fluid is and how to group or split pseudocomponents. 

 Figure 2.6
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Other information used to set up solid deposition models in 
Multiflash may also be entered.

 Figure 2.7
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Physical Property Models and Phases
Multiflash offers a wide choice of models for representing the 
properties of fluid and solid phases. Models are defined using 
the Select/Model Set menu item.

The Select Model Set window has several tabs that group 
together different types of models. Figure 2.8 shows the 
equation of state models. A number of different transport 
property options may be selected along with the thermodynamic 
models. Models that are not part of your license will be greyed 
out and cannot be selected. After choosing a model click the 
Define Model button and then Close to return to the main 
window. 

The number of phases available in a Multiflash property package 
can be controlled by the checkboxes in the lower right hand 
corner of the Select Model Set window. By default most of the 
equation of state models are set up for four phases: Gas, 
Liquid1, Liquid2 and Water (aqueous phase). In cases where 
two liquid phases in addition to water are unlikely performance 
can be improved by clearing the Liquid2 checkbox. Similarly if 
an aqueous phase will not be present the Water phase may be 
unchecked.

 Figure 2.8
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Binary Interaction Parameters
Most models require values of binary interaction parameters 
(BIPs) to make sure the model represents the interactions 
between components in a mixture. BIPs for the equation of state 
models are mostly generated automatically using correlations. 
For activity models a large number of BIPs are stored on the 
supplied BIP databanks but it is necessary for the user to enter 
any missing values. This is done using the Tools/BIPs menu 
item.

2.2.3 Carrying Out 
Calculations

Once the components, models and other parameters have been 
set up as described in Section 2.2.2 - Configuring a Property 
Package, you may use the Multiflash GUI to carry out property 
calculations.

Composition
To enter a mixture composition click on the Compositions 
button. The amount of each component can be entered in the 
mole field. The amounts are total moles or mass rather than 
mole fractions or mass fractions.

Although Multiflash does not have restrictions on the type 
and number of phases, the HYSYS flash or HYSYS unit 
operations may not support all the phases.

 Figure 2.9
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Units
Units of measurement for the Multiflash GUI can be set using 
the Select/Units menu item. This only affects operation of the 
GUI and has no connection with units in HYSYS.

 Figure 2.10
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Flash Calculations
To carry out a flash calculation set the values of known 
quantities in the Input Conditions display and select an option 
from the Calculate menu. There are toolbar buttons for many of 
the common flash calculations. Calculated properties are 
displayed in the main window. The properties calculated depend 
on the property output level selected. This can be changed using 
the Select/Property Output menu item.

 Figure 2.11
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Phase Envelope
Phase boundaries and lines of fixed volume, enthalpy, entropy 
can be plotted. Use the Calculate/Phase Envelope menu item. To 
plot a vapour-liquid phase boundary click on the VLE AutoPlot 
button – see example output below. Other types of diagrams 
may be plotted by setting the Basis and X/Y axes as required.

Matching Experimental Data
It is possible to adjust models to match measured values of 
quantities such as dew points, bubble points and viscosities for 
petroleum fluids. The mixture must include petroleum fraction 
pseudocomponents for the matching options to work. To match 
data use the Tools/Matching menu item.

 Figure 2.12
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Online Help
Help is provided by two items on the Help menu. Help Topics is 
an online version of the Multiflash for Windows User Guide and 
Multiflash Error Codes gives an explanation of any error or 
warning messages issued by Multiflash.

Returning to HYSYS
After a property package has been configured you may return to 
HYSYS by selecting the Exit item from the File menu. This will 
display a warning message:

Click OK to return to HYSYS, or Cancel to return to Multiflash to 
allow further editing of the configuration.

 Figure 2.13
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3-2 Lumper
3.1 Lumper
The Lumper is an upstream operation, which allows the user to 
blend multiple (well) streams to one stream with a reduced 
number of components to the total components into the unit 
operation. This technique is used to map petroleum and process 
thermodynamic properties together. 

The Lumper unit operation is currently available only in steady 
state mode. The user can attach one or more streams using one 
or more different fluid packages with a total of n distinct 
components. In the simulation environment, the user then adds 
a new equation of state (EOS) fluid package, fluid package 
name and components list name to lump the n distinct 
components into y components using the Montel and Gouel1 or 
Custom lumping methods. 

3.1.1 Lumper Property View
There are two ways that you can add a Lumper to your 
simulation:

1. From the Flowsheet menu, click Add Operation. The 
UnitOps view appears.

2. Click the Upstream Ops radio button.

3. From the list of available unit operations, select Lumper.

4. Click the Add button.

OR

You can also add the 
Lumper by clicking the 
F12 hot key.

You can also open the 
Object Palette by clicking 
the F4 hot key.
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1. From the Flowsheet menu, click Palette (or press F4). The 
Object Palette appears.

2. Click on the Upstream Ops icon. The Upstream Object 
Palette appears.

3. In the Upstream Object Palette, double-click the Lumper 
icon. 

The Lumper property view appears.

To delete the Lumper operation, click the Delete button. HYSYS 
will ask you to confirm the deletion.

To ignore the Lumper during calculations, activate the Ignored 
checkbox. HYSYS completely disregards the operation (and 

 Figure 3.1 

 Figure 3.2

Lumper icon

You can also delete a 
Lumper by clicking on 
the Lumper icon on the 
PFD and pressing the 
DELETE key.
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cannot calculate the outlet stream) until you restore it to an 
active state by deactivating the checkbox.

3.1.2 Design Tab
The Design tab consists of the following pages:

• Connections
• Parameters
• Lumping
• User Variables
• Notes

Connections Page
The Connections page is used to define all of the connections to 
the Lumper. You can specify the inlet streams to attach to the 
operation. The name of the operation can be changed in the 
Name field, and you can also change the name of the outlet 
stream in the Outlet Stream Name field. 

 Figure 3.3

You can specify one or 
more inlet streams using 
one or more different 
fluid packages. The fluid 
packages may have 
different component lists.
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Parameters Page
The Parameters page allows you to specify the outlet settings 
and automatic pressure assignment.

The Outlet Settings group consists of the following parameters: 

 Figure 3.4

Parameters Description

Fluid Pkg Name Allows you to specify the name for the fluid 
package to be generated.

Property Pkg You can select the Equation of State (EOS) 
property package from the drop-down list:

• Peng-Robinson
• PRSV
• Sour PR
• SRK
• Kabadi-Danner
• Sour SRK

A new fluid package with components will be 
created during the delumping process.

Comp List Name Allows you to specify the name for the component 
list to be generated.

Bulk Viscosity Fit 
Temperature 1

The first temperature at which the outlet stream 
bulk viscosity is to match that of the combined 
feed.

For more information on 
the EOS property 
packages, refer to the 
section on the Equations 
of State (EOS) in the 
HYSYS Simulation 
Basis guide.
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The Automatic Pressure Assignment group consists of the 
following radio buttons:

• Equalize All. Click this radio button, if you want to force 
all stream pressure to be the same.

• Set Outlet to Lowest Inlet. Click this radio button, if 
you want the outlet pressure to be the lowest inlet 
pressure.

Lumping Page
On the Lumping page, you can select the lumping method that 
you want to use. The outlet component list shown on the 
Lumping page can be constructed by a combination of the 
following three ways:

•  Keeping inlet components: You can select any 
number of inlet components to keep as individual 
components in the outlet component list. You can also 
click the Keep All Comps button to keep all the inlet 
components. 

• Manually creating user hypothetical components 
(User Hypos): After creating a hypothetical group, you 
can create any number of user hypos and decide the 
constituent inlet components for each user hypo. Any 
empty user hypo will be deleted from the outlet 
component list when you submit the changes or close the 
Lumper property view. 

Bulk Viscosity Fit 
Temperature 2

The second temperature at which the outlet 
stream bulk viscosity is to match that of the 
combined feed.

Flash Type with 
Respect to Feeds

You can select the flash type to be used for the 
outlet stream with respect to the combined feed. 
There are two options:

• T-P Flash
• P-H Flash

Outlet Stream 
Temperature Group

This group appears when you select T-P as the 
flash type from the Flash Type with Respect to 
Feeds drop-down list. There are two radio buttons 
in the Outlet Stream Temperature group:

• Auto Calculated. The outlet stream 
temperature will be automatically calculated 
based on the combined feed. You cannot 
specify the outlet stream temperature in the 
Value field.

• Specified. You have to specify the outlet 
stream temperature in the Value field.

Parameters Description

Inlet group
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• Automatically creating hypothetical components 
(Auto Hypos): When the desired total number of outlet 
components is more than the sum of the kept 
components and non-empty user hypos, the difference 
will be the number of auto hypos to be generated 
automatically by the lumping method you have selected. 
You can select a lumping method by expanding the 
Lumping page of the Design tab. The default method is 
Montel and Gouel. Once an auto hypo is generated, you 
are allowed to empty or delete it, but not to change the 
contained components. 

As a result, the outlet component list may contain three groups 
of components: directly kept components, user created hypos, 
and automatically generated hypos. The outlet components are 
first ordered by groups in the aforementioned order and then, 
within the first two groups, can be sorted by clicking the Sort 
Comp List button. The auto hypos cannot be sorted since they 
are generated on the fly.

 Figure 3.5

Components from 
the inlet 
components list.

Individual 
components and 
lumped 
hypothetical 
components.

You can specify the total number of outlet components in the Desired total 
number of components field. The valid range for this number depends on the 
current state of the outlet components list. The minimum number equals the 
total number of kept components and the non-empty user hypos plus one (if 
there is one or more inlet components left). The maximum number equals 
the total number of kept components and the non-empty user hypos plus the 
remaining number of inlet components. If you enter an invalid number in this 
field, the trace window will show you the valid range.
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There are currently three lumping methods:

• Montel and Gouel1. The Montel and Gouel method is 
the default lumping method. This method uses an 
iterative clustering algorithm around mobile centers, 
resulting in a classification into hypothetical components 
optimum with respect to the considered equation of state 
(EOS) and the chosen lumping properties. This method is 
therefore only applicable to the EOS property package 

For the Montel and Gouel method, both the lumping 
properties and their weights are fixed as follows:

where:  

EOS means the equation of state such as PR and SRK

sqrt (a), b and m are the square root of a, b and m 
respectively used in the EOS

Mw is the molecular weight of a component

 Figure 3.6

Lumping Property Weighting Factor

EOS sqrt (a) 1.0

EOS b 1.0

EOS m 0.1

Mw 0.5
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• Custom. The Custom method uses the same iterative 
clustering algorithm as the Montel and Gouel method, 
although you can select lumping properties and specify 
weighting factors to be used in the lumping algorithm.

• HYSYS Oil Characterization. The HYSYS Oil 
Characterization method uses the combined feed to 
construct the working curves similar to those used in the 
blend in the oil characterization. The working curves then 
are cut according to the selected cutting method which 
are: Auto Cut, User Ranges, or User Num of Cuts (in 
other words, exactly the same as in the blend).

 Figure 3.7

 Figure 3.8

You must add at least one 
lumping property.

The weighting factors 
must be between 0 and 1.

Refer to Section 4.2 - 
Oil Characterization 
from the HYSYS 
Simulation Basis guide 
for more information.
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Sorting the Inlet Components

You can sort the available components in the inlet group by 
clicking on the appropriate radio button. 

When the HYSYS Oil Characterization method is used in 
lumping, the generated hypothetical components do not 
have the knowledge on the distribution of the inlet 
components. Therefore, if the inlet components are first 
lumped using this method, the delumping will not be able to 
recover the original inlet components, except the ones kept 
in the lumper's outlet component list.

Radio Button Description

None The components remain in the original order. This is the 
order when you added the components to the fluid 
package component list.

Boiling Point You can sort the components according to the boiling 
point of each component.

Molecular 
Weight

You can sort the components according to the molecular 
weight of each component.

Molar Flow 
(Rev)

You can sort the components according to the molar flow 
of each component. The component with the largest 
molar flow is on the top. 
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Creating a Hypothetical Group

You can create a hypothetical group.

1. Click the Create Hypo Group button. The Hypo Group view 
appears.

2. If you want to change the Hypo group name, type the new 
name in the Group Name field.

 Figure 3.9

The hypothetical group created by the lumper is also 
managed by the lumper. Therefore, you have very limited 
access to the functionality of the group.

The Lumper Hypothetical 
group name appears on 
the Hypothetical tab of 
the Simulation Basis 
Manager when you enter 
the Basis environment. 
Refer to Section 5.2.3 - 
Hypotheticals Tab in 
the HYSYS User Guide 
for more information.

The Component Class 
field on the Hypo Group 
view shows the class for 
grouping the 
hypotheticals. 
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3. In the Individual Hypo Controls group, click the appropriate 
radio button to select the Basic Hypothetical component 
properties to view in the table. The table view changes 
according to the radio button that has been selected. 

4. Click the Estimation Methods button to setup property 
estimation methods for the contained hypothetical 
components. The Property Estimation view appears.

 Figure 3.10

 Figure 3.11

Refer to the section on 
the Base Properties in 
the HYSYS Simulation 
Basis guide for more 
information.

Refer to the section on 
the Vapour Pressure 
Properties in the HYSYS 
Simulation Basis guide 
for more information.

Base Properties Table

Vapour Pressure Table 

For more information on 
the Estimation Methods, 
refer to the section on the 
Estimation Methods in 
the HYSYS Simulation 
Basis guide.
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5. On the Property Estimation view, select the property to set 
the methods for from the Property to Set Methods For list. 
Then, from the Estimation Method For Selected 
Property drop-down list, select the estimation method. The 
default estimation method is Default Method.

6. Close the Property Estimation view to return to the Hypo 
Group view.

7. If you want to add notes to the hypothetical group, click the 
Notes button. The Notes and Descriptions for Hypothetical 
Group view appears.

The Notes and Descriptions for Hypothetical Group view 
provides a text editor that allows you to record any 
comments or information regarding the hypothetical group. 
After you have added the notes, close the Notes and 
Descriptions for Hypothetical Group view to return to the 
Hypo Group view.

 Figure 3.12

 Figure 3.13
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8. Close the Hypo Group view to return to the Lumper property 
view.

Once you have closed the Hypo Group view, you will notice 
that the Create Hypo Group button is now the Edit Hypo 
Group button and that the Delete Hypo Group and Create 
User Hypo buttons are now enabled on the Lumper page.

Editing a Hypothetical Group
1. Click the Edit Hypo Group button. The Hypo Group view 

appears.
2. From here you can change the estimation methods, add 

notes, change the group name and the basic hypothetical 
component properties.

Deleting a Hypothetical Group

1. Click the Delete Hypo Group button.
2. HYSYS will prompt you to confirm the deletion of the hypo 

group.

Deleting the hypothetical group will also delete all the 
hypothetical components it contains, including both user 
created and auto-generated hypothetical components.

You can also access the 
hypothetical groups from 
the Basis environment.

1. From the Simulation 
menu, select Enter 
Basis Environment. 
The Simulation Basis 
Manager appears.

2. Click on the 
Hypotheticals tab. 

3. Select the hypothetical 
group you want to edit 
from the Hypotheticals 
Groups list.

4. Click the View button. 
The Hypo Group View 
appears. 
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Creating a User Lumped Hypothetical 
Component

After you have created a hypothetical group, you can create a 
new lumped hypothetical component. 

1. Click the Create User Hypo button. 
2. The created lumped hypothetical component is displayed in 

the outlet components list. The Hypo field of the Hypo 
Design group allows you to change the name of the lumped 
hypothetical component.

Deleting a User Lumped Hypothetical 
Component 
1. From the list of components in the Outlet group, select the 

lumped hypothetical component you want to delete.
2. Click the Delete User Hypo button.

 Figure 3.14

HYSYS does not prompt you to confirm the deletion of your 
lumped hypothetical component. After the lumped 
hypothetical component is deleted, the information cannot 
be retrieved.
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Viewing a Lumped Hypothetical Component

You can view both the user created and auto generated lumped 
hypothetical components from the Hypo Group view.

1. Click the Edit Hypo Group button. The Hypo Group view 
appears.

2. From the Individual Controls group, click the View button. 

3. The information that appears corresponds to the 
hypothetical group the lumped hypothetical component is 
associated with. 

For more information on the lumped hypothetical component 
property view, refer to Section 3.5 - Hypothetical 
Component Property View in the HYSYS Simulation Basis 
guide.

You are not allowed to alter any data in a hypothetical 
component created by a lumper.

 Figure 3.15

You can also view the 
lumped hypothetical 
property view from the 
Basis environment.

1. From the Simulation 
menu, select Enter 
Basis Environment. 
The Simulation Basis 
Manager appears.

2. Click on the 
Hypotheticals tab. 

3. Select a lump 
hypothetical 
component from the 
Hypothetical Quick 
Reference table and 
click the View Hypo 
button. 
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Adding Components to a User Lumped 
Hypothetical Component

You can add inlet components to the created lumped 
hypothetical component.

1. From the list of available components in the Inlet group, 
select the components you want to add.

2. Click the Add to User Hypo button.

3. The hypothetical components are displayed in the 
Constituent Components list of the Hypo Design group.

If you want to add all the inlet components to the lumped 
hypothetical component, click on the first inlet component in 
the list. Then press SHIFT and click on the last inlet 
component in the list. All the inlet components will be 
highlighted. Alternatively, you can also press SHIFT END.

If you want to add individual inlet components to the lumped 
hypothetical component, press and hold down the CTRL key 
then click on the inlet components you want to add to the 
lumped hypothetical component. The selected inlet 
components will be highlighted.

 Figure 3.16

Inlet group
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Removing a Component from the User Lumped Hypothetical 
Component

1. From the list of constituent components in the Outlet group, 
select the components you want to remove.

2. Click the Remove from Hypo button. The components will 
now be moved back to the Available Components list in the 
Inlet group.

Keeping All Inlet Components 

You can add all inlet components to the output component list if 
you have not created a lumped hypothetical component by 
clicking the Keep All Comps button. 

Keeping Individual Components

You can add individual components from the inlet components 
list to the output component list.

1. From the available components list of the Inlet group, select 
the component you want to add to the output component 
list.

2. Click the Add to Keep button. The selected inlet component 
is added to the outlet component list of the Outlet group.

Removing Components
1. From the components list in the Outlet group, select the 

individual component you want to remove.
2. Click the Remove Comp button. The component will now be 

displayed in the inlet component list.

Ensure that you have a 
lumped hypothetical 
component selected in 
the outlet components list 
before you can remove 
the component.

Ensure that you have a 
component selected in 
the outlet components list 
before you can remove 
the component.
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Sorting the Outlet Component List

You can only sort the outlet component list if you have at least 
two individual components or two user lumped hypothetical 
components. 

1. Click the Sort Comp List button in the Outlet group. The 
Sorting Output Components view appears.

2. From the Sort List group, click the appropriate radio button. 
You can sort the individual components or user lumped 
hypothetical components in the outlet component list.

3. From the Component(s) to Move list, select the component 
you want to move. Then, from the Insert Before list, select 
the component that you want the moved component to be 
inserted before. 

4. Click the Move button to move the component.

From example, if you have three lumped hypothetical 
components as shown in Figure 3.17. When you select 
Hypo20000 from the Component(s) to Move list, then you 
select Hypo20002 from the Insert before list and click the 

 Figure 3.17

If you have one individual 
component and one 
lumped hypothetical 
component the Sort 
Comp List button remains 
disabled.

You cannot sort the 
automatically lumped 
hypothetical components.

When you click the 
Comps to Keep radio 
button, the Sorting 
Output Components 
view shows the 
individual components 
that you can sort in the 
outlet components list.

When you click the User 
Hypos radio button, the 
Sorting Output 
Components view shows 
the user lumped 
hypothetical components 
that you can sort in the 
outlet components list.
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Move button, Hypo20000 will be inserted between 
Hypo20001 and Hypo20002 as shown in the figure below. 

5. Close the Sorting Output Components view to return to the 
Lumper property view.

Emptying and Deleting an Auto Lumped 
Hypothetical Component

If the desired total number of outlet components is more than 
the sum of the individual components and the user lumped 
hypothetical components, HYSYS will make up the difference by 
automatically generating the required number of hypos using 
the chosen lumping method. You can remove all the components 
from an automatically lumped hypothetical component.

1. From the outlet components list, select the automatically 
lumped hypothetical component you want to remove all 
components from.

2. Click the Empty Auto Hypo button. The components will 
now be displayed in the inlet component list.

 Figure 3.18

The desired total number 
of output components is 
indicated in the Desired 
total number of 
components field. 

The Empty Auto Hypo and 
Delete Auto Hypo buttons 
are active only when you 
have selected an 
automatically lumped 
hypothetical component 
in the outlet component 
list.
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To delete the automatically lumped hypothetical component:

1. From the outlet components list, select the automatically 
lumped hypothetical component you want to delete.

2. Click the Delete Auto Hypo button. 

Calculating the Lumper Unit Operation

The Submit Changes button is enabled when there is sufficient 
information for the lumper to calculate. By clicking this button, 
HYSYS will calculate the unit operation based on the current 
information. Therefore, the Submit Changes button can be 
viewed as an ad hoc test button.

Closing the Lumper Property View and On-
the-Fly Calculations

When the Lumper property view is open, HYSYS assumes that 
the lumper is still in editing mode and most of the calculations 
are on hold. Therefore, you must click the Submit Changes 
button to calculate the unit operation. If you have finished 
editing and want to enable on-the-fly calculations, you have to 
close the Lumper property view.

User Variables Page
The User Variables page allows you to create and implement 
variables in the HYSYS simulation case. For more information on 
implementing the User Variables, refer to Chapter 5 - User 
Variables in the HYSYS Customization Guide.

HYSYS does not prompt you to confirm the deletion of your 
automatically lumped hypothetical component. After the 
automatically lumped hypothetical component is deleted, the 
information cannot be retrieved.

Ensure that you have an 
automatically lumped 
hypothetical component 
selected in the outlet 
components list before 
you can delete.

If you want to test what 
happens with the current 
changes, click the Submit 
Changes button. If you 
have finished editing, 
close the view to enable 
on-the-fly calculations. 
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Notes Page
The Notes page provides a text editor that allows you to record 
any comments or information regarding the specific unit 
operation, or the simulation case in general. For more 
information, refer to Section 7.20 - Notes in the HYSYS User 
Guide.

3.1.3 Rating Tab
This unit operation currently does not have rating features.

3.1.4 Worksheet Tab
The Worksheet tab contains a summary of the information 
contained in the stream property view for all the streams 
attached to the operation. 

3.1.5 Dynamics Tab
This unit operation is currently not available for dynamic 
simulation.

Refer to Section 1.3.1 - 
Worksheet Tab in the 
HYSYS Operations 
Guide for more 
information.
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3.2 Delumper
The Delumper is an upstream unit operation used to delump the 
lumped hypothetical components created by one or more 
lumpers.

You can attach one or more feed streams using one or more 
different fluid packages (hence potentially different component 
lists), with a total of m distinct components. In the Delumper 
property view, you can specify a new equation of state (EOS) 
fluid package, a new fluid package name and a new components 
list name. 

By using the currently available Component Recovery delumping 
method, you can recover part or all of the original components 
from the lumped hypothetical components, with a total of n 
outlet components, where .

As a result, the outlet component list may include the individual 
components from the input list, and recovered components from 
the lumped components in the input components list. 

For information on the 
Lumper unit operation, 
refer to Section 3.1 - 
Lumper.

 Figure 3.19

The Delumper does not have to be connected to a Lumper 
directly in order to delump its lumped components. 
Furthermore, the Component Recovery delumping method is 
capable of recovering the very original constituent 
components from a lumped hypothetical component, 
regardless how many layers of lumping have been 
conducted.

n m≥
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3.2.1 Delumper Property View
There are two ways that you can add a delumper to your 
simulation:

1. From the Flowsheet menu, click Add Operation. The 
UnitOps view appears.

2. Click the Upstream Ops radio button.

3. From the list of available unit operations, select Delumper.

4. Click the Add button. 

OR

1. From the Flowsheet menu, click Palette. The Object 
Palette appears.

2. Click on the Upstream Ops icon. The Upstream Object 
Palette appears.

3. In the Upstream Object Palette, double-click the Delumper 
icon. 

 Figure 3.20 

You can also add the 
delumper by clicking the 
F12 hot key.

You can also open the 
Object Palette by clicking 
the F4 hot key.

Delumper icon
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The Delumper property view appears.

To delete the Delumper operation, click the Delete button. 
HYSYS will ask you to confirm the deletion.

To ignore the Delumper during calculations, activate the Ignored 
checkbox. HYSYS completely disregards the operation (and 
cannot calculate the outlet stream) until you restore it to an 
active state by deactivating the checkbox.

3.2.2 Design Tab
The Design tab consists of the following pages:

• Connections
• Parameters
• Delumping
• User Variables
• Notes

 Figure 3.21

You can also delete a 
Delumper by clicking on 
the Delumper icon on 
the PFD and pressing 
the DELETE key.
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Connections Page
The Connections page is used to define all of the connections to 
the Delumper. You can specify the inlet streams to attach to the 
operation. The name of the operation can be changed in the 
Name field, and you can also change the name of the outlet 
stream in the Outlet Stream Name field.

 Figure 3.22

You can specify one or 
more inlet streams using 
one or more different 
fluid packages. The fluid 
packages may have 
different component lists.
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Parameters Page
The Parameters page allows you to specify the outlet settings 
and automatic pressure assignment. 

The Outlet Settings group consists of the following parameters: 

 Figure 3.23

Parameters Description

Fluid Pkg Name Allows you to specify the name for the fluid 
package to be generated.

Property Pkg You can select the Equation of State (EOS) 
property package from the drop-down list:

• Peng-Robinson
• PRSV
• Sour PR
• SRK
• Kabadi-Danner
• Sour SRK

A new fluid package with components will be 
created during the delumping process.

Comp List Name Allows you to specify the name for the component 
list to be generated.

Bulk Viscosity Fit 
Temperature 1

The first temperature at which the outlet stream 
bulk viscosity is to match that of the combined 
feed.

For more information on 
the EOS property 
packages, refer to the 
section on the Equations 
of State (EOS) in the 
HYSYS Simulation 
Basis guide.
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The Automatic Pressure Assignment group consists of the 
following radio buttons:

• Equalize All. Click this radio button, if you want to force 
all stream pressure to be the same.

• Set Outlet to Lowest Inlet. Click this radio button, if 
you want the outlet pressure to be the lowest inlet 
pressure.

Bulk Viscosity Fit 
Temperature 2

The second temperature at which the outlet 
stream bulk viscosity is to match that of the 
combined feed.

Flash Type with 
Respect to Feeds

You can select the flash type to be used for the 
outlet stream with respect to the combined feed. 
There are two options:

• T-P Flash
• P-H Flash

Outlet Stream 
Temperature Group

This group appears when you select T-P as the 
flash type from the Flash Type with Respect to 
Feeds drop-down list. There are two radio buttons 
in the Outlet Stream Temperature group:

• Auto Calculated. The outlet stream 
temperature will be automatically calculated 
based on the combined feed. You cannot 
specify the outlet stream temperature in the 
Value field.

• Specified. You have to specify the outlet 
stream temperature in the Value field.

Parameters Description
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 Delumping Page
On the Delumping page, you can select the delumping method 
that you want to use. 

There is currently one delumping method: 

Component Recovery: You may choose to recover none to 
all of the lumped input hypothetical components. The default 
is to recover all lumped hypothetical components to their 
original constituent components, regardless how many times 
the components have been lumped, as well as how many 
intermediate unit operations exist between the lumpers and 
the current delumper. 

 Figure 3.24

For the Component 
Recovery method only the 
lumped hypothetical 
components can be 
delumped.
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The outlet component list may include the individual 
components from the input list, and recovered components from 
the lumped components in the input components list. 

Sorting the Available Lumped Hypothetical 
Components

You can sort the available lumped hypothetical components in 
the inlet group by clicking on the appropriate radio button. 

 Figure 3.25

Radio Button Description

None The components remain in the original order. This is the 
order when you added the components to the fluid 
package component list.

Boiling Point You can sort the components according to the boiling 
point of each component.

Molecular 
Weight

You can sort the components according to the molecular 
weight of each component.

Molar Flow 
(Rev)

You can sort the components according to the molar flow 
of each component. The component with the largest 
molar flow is on the top. 

Components in 
the outlet 
component list.

Delumped 
hypothetical 
components

Components 
packaged in the 
delumped 
hypothetical 
components.

HYSYS calculates the total number of the 
outlet components. 
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Delumping All Available Lumped 
Hypothetical Components

You can delump all the lumped hypotheticals that are shown in 
the available lumped hypothetical list of the Inlet group.

To delump all the available lumped hypothetical components:

1. Click the Delump All Hypos button.
2. The delumped hypothetical components appear in the 

Delumped Hypos group.

Delumping Available Lumped Hypothetical 
Components

You can delump the lumped hypothetical components from the 
inlet components list to the delumped hypos list. 

1. From the Avail. Lumped Hypos list of the Inlet group, select 
the lumped hypothetical component you want to delump.

2. Click the Delump Hypo button. The selected lumped 
hypothetical component appears in the Delumped Hypos 
group. 

 Figure 3.26
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Keeping All Available Lumped Hypothetical 
Components

You can keep all the lumped hypotheticals that are shown in the 
available lumped hypothetical list of the Inlet group.

1. Click the Keep All Hypos button.
2. The lumped hypothetical component appears in the outlet 

components list of the Outlet group.

Keeping Available Lumped Hypothetical 
Components

You can add lumped hypothetical components from the inlet 
components list to the output component list.

1. From the Avail. Lumped Hypos list of the Inlet group, select 
the lumped hypothetical component you want to add to the 
output component list.

2. Click the Add Hypo to Keep button. The selected lumped 
hypothetical component is added to the outlet component 
list of the Outlet group.

 Figure 3.27
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Removing Kept Lumped Hypothetical 
Components
1. From the components list in the Outlet group, select the 

lumped hypothetical component you want to remove.
2. Click the Remove Kept Hypo button. The lumped 

hypothetical component will now be displayed in the inlet 
component list.

Restoring the Delumped Hypothetical 
Components

You can restore the delumped hypothetical components.

1. From the Delumped Hypos group, select the delumped 
hypothetical component you want to restore.

2. Click the Restore Hypo button. The delumped hypothetical 
component appears in the Avail. Lumped Hypos list of the 
Inlet group.

You cannot remove the individual components from the 
outlet component list.

 Figure 3.28

Ensure that you have the 
lumped hypothetical 
component selected in 
the outlet components list 
before you can remove 
the lumped hypothetical 
component.
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Sorting the Output Components

You can sort the available components in the Outlet Components 
list by clicking on the Sort Comp List button. The Sorting 
Outputs Components for Delumper view appears.

In the Sort Method group, you can select the method you want 
to use to sort the output components by clicking on the Manual 
or Automatic radio button.

 Figure 3.29

The outlet component list 
may include the individual 
components from the 
input list, and recovered 
components from the 
lumped components in 
the input components list.
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Manual Sort Method

By default the Manual radio button is selected. To sort manually:

1. From the Component(s) to Move list, select the component 
you want to move. The Move button is enabled.

2. From the Insert Before list, select the component you want 
the component from the Component(s) to Move list to be 
inserted before.

3. Click the Move button. For example, the figure below shows 
that Propane has been moved before 3-Mhexane.

4. Close the Sorting Outputs Components for Delumper view to 
return to the Delumping page.

 Figure 3.30

 Figure 3.31
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Automatic Sort Method

When you select the Automatic radio button, the Sort By group 
appears. 

Calculating the Delumper Unit Operation

The Submit Changes button is enabled when there is sufficient 
information for the Delumper to calculate. By clicking this 
button, HYSYS will calculate the unit operation based on the 
current information. Therefore, the Submit Changes button can 
be viewed as an ad hoc test button.

Closing the Delumper Property View and On-
the-Fly Calculations

When the Delumper property view is open, HYSYS assumes that 
the delumper is still in editing mode and most of the calculations 
are on hold. Therefore, you must click the Submit Changes 
button to calculate the unit operation. If you have finished 
editing and want to enable on-the-fly calculations, you have to 
close the Delumper property view.

 Figure 3.32

Radio Button Description

None The components will be put in the order before the 
sorting view is launched. 

Boiling Point You can sort the components according to the boiling 
point of each component.

Molecular 
Weight

You can sort the components according to the molecular 
weight of each component.

Molar Flow 
(Rev)

You can sort the components according to the molar flow 
of each component. The component with the largest 
molar flow is on the top. 

If you want to test what 
happens with the current 
changes, click the Submit 
Changes button. If you 
have finished editing, 
close the view to enable 
on-the-fly calculations. 
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User Variables Page
The User Variables page allows you to create and implement 
variables in the HYSYS simulation case. For more information on 
implementing the User Variables, refer to Chapter 5 - User 
Variables in the HYSYS Customization Guide.

Notes Page
The Notes page provides a text editor that allows you to record 
any comments or information regarding the specific unit 
operation, or the simulation case in general. For more 
information, refer to Section 7.20 - Notes Manager in the 
HYSYS User Guide.

3.2.3 Rating Tab
This unit operation currently does not have rating features.

3.2.4 Worksheet Tab
The Worksheet tab contains a summary of the information 
contained in the stream property view for all the streams 
attached to the operation. 

3.2.5 Dynamics Tab
This unit operation is currently not available for dynamic 
simulation.

3.3 References
 1 Montel, F and Gouel P.L., A new Lumping Scheme of Analytical Data 

for Compositional Studies. Presented at the 59th Annual Technical 
Conference and Exhibition, Houston, Sept. 16-19, 1984; Paper SPE 
13119.

Refer to Section 1.3.1 - 
Worksheet Tab in the 
HYSYS Operations 
Guide for more 
information.
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4-2 Introduction
4.1 Introduction
The HYSYS Liquid-liquid Hydrocyclone predicts the performance 
of an oily water cleaning unit operation. The Liquid-liquid 
Hydrocyclone generates results based on the Migration 
Probability Theory. An oil droplet size distribution based on a 
sauter mean diameter is applied and the resulting volume of oil 
separated is calculated.

The Liquid-liquid Hydrocyclone is designed to be easy to use 
with a single input tab giving liner details and the oil droplet 
distribution. Process details, Hydrocyclone liner dimensionless 
parameters, and separation performance are calculated. You 
have the option of modelling two different types of liner: 

• Vortoil G-liners
• Serck Baker Oilspin liners

The fundamental calculation methods are similar for both liners. 
The hydraulic parameters however vary considerably.

4.1.1 Theory
The Liquid-liquid Hydrocyclone operation performs the following 
calculations to generate the results:

• Oil Droplet Distribution
• Hydrocyclone Liner Dimensions
• Hydrocyclone Hydraulics
• Oil Droplet Migration Probability
• Hydrocyclone Separation Efficiency
4-2
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Oil Droplet Distribution
The Liquid-liquid Hydrocyclone uses a Rosin Rammler Oil Droplet 
Distribution to describe the dispersion at the Inlet. A two 
parameter Cumulative Distribution is defined. 

The Cumulative Distribution is defined by the following 
equation:

where:

F(d) = cumulative distribution

d = droplet diameter

drm = Rosin Rammler modal diameter

n = exponential power index

The Rosin Rammler modal diameter drm can be related to 
another mean diameter dM by the following equation.

where:  

f(d) = fraction undersize at diameter dM

(4.1)

(4.2)

F d( ) 1 d
drm
-------- 
  n– 

 exp–=

dM drm 1 f d( )–( )ln–[ ]1 n⁄×=
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Hydrocyclone Liner Dimensions
The Hydrocyclone Dimensions are based on the following 
variables:

• Dimensions Schematic

• Characteristic Diameter (D). The Hydrocyclone 
characteristic diameter is defined by the user.

• Inlet Diameter (DIN). The Inlet diameter is set at 0.35D.
• Underflow Diameter (DW). The Underflow diameter is set 

at 0.50D.
• Overflow Diameter (DO). The Overflow diameter is 

defined by the user.
• Taper Angles. The Taper angles  and  define the 

Separation section geometry.

 Figure 4.1
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• Lengths. The length of each taper section is calculated 
from the Taper angles (  and ) and the characteristic 
diameter (D). The length from the end of the taper 
section to the liner tip is taken as 20D. These lengths are 
then summed to give a total liner Length (L).

Hydrocyclone Hydraulics
The Hydrocyclone can be modelled Hydraulically in a dimensionless 
manner assuming geometrically similar criteria. A Reynolds 
number and Hydrocyclone number can be defined using 
dimensions, fluid parameters, and operating conditions. Split 
Ratio and Maximum flow are also determined from the operating 
data.

• Reynolds Number. ReD is expressed as:

where:  

QT = volumetric flow rate 

 = continuous phase density

DH = Hydrocyclone Characteristic Diameter 

 = continuous phase viscosity

• Hydrocyclone Number. Hy75 relating to an oil droplet 
diameter d'75 may be defined as:

where:  

QT = volumetric flow rate

 = oil and water density difference

d'75 = 75% Migration Probability Droplet Diameter

DH = Hydrocyclone Characteristic Diameter

(4.3)

(4.4)

θ1 θ2

ReD
QT ρc×

900 π DH µc×××
--------------------------------------------=

ρc

µc

Hy75
QT ∆ρ d′75

2××

3600 DH
3 µc××

----------------------------------------=

∆ρ
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 = continuous phase viscosity

The Hydrocyclone Number can also be related to the Reynolds 
number for similar geometric units by means of the following 
general equation:

Experimental or Production performance data can be used to 
establish the values of a and b. These constants are Liner 
specific.

• Split Ratio. Split Ratio is calculated from the user defined 
Pressure Differential Ratio (PDR) by means of a quadratic 
expression:

where:  

 = parameter values established from a curve fit to 
operating data

• Maximum Flowrate. Maximum flow rate for the system is 
related to the pressure differential between the Inlet and 
Reject streams:

where:  

nL = number of Liners

PIN = Inlet pressure

PREJ = Overflow pressure

k, n = constant values established from hydraulic data

(4.5)

(4.6)

(4.7)

µc

Hy75 a ReD( )b=

F α PDR( )2 β PDR( ) γ+ +=

α β γ,,

QMAX nL k PIN PREJ–( )n×=
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Oil Droplet Migration Probability
The method of Dense Dispersion Hydrocyclones is applied to predict 
the volume of oil separated from the Inlet stream. A Migration 
Probability for the droplet distribution is derived from statistical 
theory and a Reduced Migration Probability.

• Migration Probability. For a given Inlet oil droplet 
distribution the Migration Probability (MP) of a droplet of 
diameter d microns is defined as the chance that it will 
be separated in the oil overhead stream. The MP can be 
related to the Reduced Migration Probability (RMP) and 
the Split Ratio (F) by the following expression:

• Reduced Migration Probability. An analytical function may 
be fitted to represent the centre of an envelope of 
experimental curves for a particular liner. This Reduced 
Migration Probability (RMP) can be represented generally 
in terms of a normalised droplet diameter  as:

where:  

a, b, c = constants determined by experiment

 dimensionless droplet diameter

d'75 = determined from the Hydrocyclone Number

d = droplet diameter from the Distribution

(4.8)

(4.9)

MP d( ) RMP d( ) 1 F–( )× F+=

∆75

RMP 1 a ∆75 b–[ ]c( )exp–=

∆75
d
d′75
---------=
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• Graphical Representation. The Migration Probability for 
an Oil Droplet Distribution is represented graphically as:

Hydrocyclone Separation Efficiency
The Separation Efficiency ( ) of the Hydrocyclone vessel is 
calculated from Inlet and Outlet streams oil concentrations:

where:  

Ci = Inlet stream oil concentrations 

Co = Overflow stream oil concentrations

 Figure 4.2

(4.10)

ε

ε 100 1
Co
Ci
------– 

 =
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4.2 Liquid-liquid 
Hydrocyclone Property 
View

There are two methods to add a Liquid-liquid Hydrocyclone to 
your simulation:

1. From the Flowsheet menu, click Add Operation. The 
UnitOps view appears.

2. Click the Upstream Ops radio button.

3. From the list of available unit operations, select Liquid-
liquid Hydrocyclone.

4. Click the Add button. 

OR

1. From the Flowsheet menu, select Palette (or press F4). 
The Object Palette appears.

2. In the Object Palette, click the Upstream Ops icon to open 
the Upstream Object Palette.

3. In the Upstream Object Palette, double-click the Liquid-
Liquid Hydrocyclone icon.

 Figure 4.3

You can also access the 
UnitOps view by pressing 
F12.

Liquid-Liquid 
Hydrocyclone icon
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The Liquid-liquid Hydrocyclone property view appears.

To delete the Liquid-liquid Hydrocyclone operation, click the 
Delete button. HYSYS will ask you to confirm the deletion.

To ignore the Liquid-liquid Hydrocyclone during calculations, 
select the Ignored checkbox. HYSYS completely disregards the 
operation (and cannot calculate the outlet stream) until you 
restore it to an active state by clearing the checkbox.

4.2.1 Design Tab
The Design tab consists of the following pages:

• Connections
• Parameters
• Liner Details
• Droplet Distribution
• User Variables
• Notes

Connections Page
The Connections page is used to define all of the connections to 
the Liquid-liquid Hydrocyclone. You can specify the inlet stream, 
overflow outlet stream, and underflow outlet stream attached to 

 Figure 4.4

You can also delete a 
Liquid-liquid 
Hydrocyclone by clicking 
on the Liquid-liquid 
Hydrocyclone icon on 
the PFD and pressing 
DELETE.

You can select a different 
fluid package associated 
to the Liquid-liquid 
Hydrocyclone using the 
Fluid Package drop-down 
list.
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the operation. The name of the operation can be changed in the 
Name field. 

 Figure 4.5
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Parameters Page
The Parameters page allows you to specify the Liquid-liquid 
Hydrocyclone operation parameters.

The following table lists and describes the parameters available 
in the Parameters page:

 Figure 4.6

Object Description

Liner Type drop-
down list

Allows you to choose between two types of Vessel 
liner:

• Vortoil G-Liners
• Serck Baker Oil Spin

Hydraulic parameters and physical Dimensions 
change between the two types of Liner.

Number of Liners cell Allows you to specify the number of active vessel 
liners. 

Min. Flowrate cell Displays the minimum flow rate per liner 
depending on the selected Liner type.

• Vortoil recommends a minimum value of 
2m3/hr for the G-Liner.

• Serck Baker recommends a minimum value 
of 4m3/hr for the OilSpin Liner.

Min. Reject Pressure 
cell

Allows you to specify the minimum Oil Overflow 
(Reject) downstream pressure.

PDR cell Allows you to specify the Pressure Differential 
Ratio. The PDR is the ratio of the following stream 
pressure drops:

PDR Inlet Pressure Overflow Pressure–
Inlet Pressure Underflow Pressure–
--------------------------------------------------------------------------------------=
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Liner Details Page
The Liner Details page allows you to manipulate the selected 
Liner type.

The following table lists and describes the parameters available 
for modification in the Liner Details page:

Split Ratio cell Allows you to specify the volume percent of the 
total inlet stream that passes to the overflow 
stream.

Underflow DP cell Allows you to specify the pressure difference 
between the inlet stream and the underflow 
stream.

Underflow Pressure 
cell

Displays the pressure of the underflow stream.

 Figure 4.7

Object Description

Liner Type drop-
down list

Allows you to choose between two types of Vessel 
liner:

• Vortoil G-Liners
• Serck Baker Oil Spin

Hydraulic parameters and physical Dimensions 
change between the two types of Liner.

Characteristic 
Diameter cell

Allows you to specify the liner characteristic 
diameter, which is used to determine the diameter 
for the Inlet and Underflow.

Inlet Diameter cell Displays the calculated inlet diameter value.

Object Description
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Droplet Distribution Page
The Droplet Distribution page allows you to manipulate the 
Liquid-liquid Hydrocyclone performance, by modifying the 
dispersed oil droplet distribution.

The size distribution of oil droplets at the Hydrocyclone inlet is 
calculated using two parameters of the Rosin Rammler distribution. 
The Rosin Rammler distribution calculation is based on a mean 
droplet diameter and an exponential term power index. 

Upper Taper cell Displays the upper taper angle. 

Lower Taper cell Displays the lower taper angle.

Overflow Diameter 
cell

Allows you to specify the Overflow diameter.

Underflow Diameter 
cell

Displays the calculated Underflow diameter based 
on the selected Liner type and the specified 
characteristic diameter.

Total Length cell Displays the Liner overall length of the selected 
Liner type’s hydrocyclone geometry.

 Figure 4.8

Object Description
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The following table lists and describes the distribution 
parameters:

User Variables Page
The User Variables page allows you to create and implement 
variables in the HYSYS simulation case. For more information on 
implementing the User Variables, refer to Chapter 5 - User 
Variables in the HYSYS Customization Guide.

Notes Page
The Notes page provides a text editor that allows you to record 
any comments or information regarding the specific unit 
operation, or the simulation case in general. 

Parameter Description

Droplet Sauter Mean This is the droplet diameter whose volume to 
surface area ratio is the same as that of the 
distribution as a whole and so represents the 
surface area mean diameter.

Droplet d50 This is the diameter of droplet at the 50% 
undersize point on a cumulative volume 
distribution curve.

Droplet d95 This is the diameter of droplet at the 95% 
undersize point on a cumulative volume 
distribution curve.

Rosin Rammler 
Index

This is the power term to which the exponential 
part of the Rosin-Rammler Distribution is raised. 
Usually the value is between 1 and 2.5.

For more information, 
refer to Section 7.20 - 
Notes Manager in the 
HYSYS User Guide.
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4.2.2 Performance Tab
The Performance tab displays the calculated performance 
results of the Liquid-liquid Hydrocyclone.

General Page
The General page displays the calculated general Liner 
performance results.

• Inlet oil concentration in parts per million (ppm) by 
volume and mg/l

• Maximum flow rate for the vessel. This value is 
calculated from the Liner hydraulic characteristics.

• Droplet diameter separated with 75% efficiency at 
operating conditions

• Pressure drops at Overflow and Underflow relative to the 
Inlet

• System Reject Ratio
• System separation efficiency

 Figure 4.9
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Geometric Page
The Geometric page displays the calculated geometric Liner 
performance results.

• Hydrocyclone Reynolds Number based on the 
Characteristic diameter

• Hydrocyclone Number (Hy75)

Overflow Page
The Overflow page displays the calculated Overflow results.

• Overflow pressure
• Volumetric flowrate
• Oil concentration in ppm

 Figure 4.10

 Figure 4.11
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Underflow Page
The Underflow page displays the calculated Underflow results.

• Underflow pressure
• Volumetric flowrate
• Oil concentration in ppm and mg/l

Tables Page
The Tables page displays the tabulated results of the Oil Droplet 
Distribution or the Migration Probability. To view either results select 
the appropriate radio button.

 Figure 4.12

 Figure 4.13
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Plots Page
The Plots page displays in graph format the results of the Oil 
Droplet Distribution or the Migration Probability. To view either plot 
select the appropriate radio button.

4.2.3 Worksheet Tab
The Worksheet tab contains a summary of the information 
contained in the stream property view for all the streams 
attached to the operation. 

4.2.4 Dynamics Tab
This unit operation is currently not available for dynamic 
simulation.

 Figure 4.14

Refer to Section 1.3.1 - 
Worksheet Tab in the 
HYSYS Operations 
Guide for more 
information.
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4.3 Nomenclature
The following Nomenclature has been adopted for the Liquid-
liquid Hydrocyclone calculations:

Variable Symbol Units

Volumetric Flowrate m3/hr

Maximum Volumetric Flowrate m3/hr

Inlet Pressure Bar

Overflow Pressure Bar

Underflow Pressure Bar

Continuous Phase Density kg/m3

Oil Droplet Density kg/m3

Hydrocyclone Characteristic 
Diameter

m

Continuous Phase Viscosity Pa.s

Droplet Diameter microns

Sauter Mean Droplet Diameter microns

50% Droplet Diameter microns

75% Droplet Diameter microns

95% Droplet Diameter microns

75% Migration Probability Droplet 
Diameter

microns

Dimensionless Droplet Diameter

Pressure Differential Bar

Separation Efficiency %

Inlet Oil Concentration ppm Vol.

Underflow Oil Concentration ppm Vol.

Split Ratio

Hydrocyclone Reynolds Number

Hydrocyclone Number

QT

QMAX

PIN

PREJ

POUT

ρc

ρo

D

µc

d

d3 2,

d50

d75

d95

d′75

∆75

∆P

ε

Ci

Co

F

ReD

Hy75
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Number of Liners

Total Liner Length m

Upper Taper Angle degrees

Lower Taper Angle degrees

Variable Symbol Units

nL

L

θ1

θ2
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5-2 Introduction
5.1 Introduction
We are pleased to introduce the PIPESIM Single Branch 
Extension to HYSYS - the first and only commercial coupling 
between petroleum and process simulation. This extension is a 
result of a collaborative development between Hyprotech and 
Baker Jardine. Together we are working on a vision of “Total 
Hydrocarbon Asset Management”. Examining the sensitivity of 
production and process systems simultaneously or performing 
production system optimization can yield significant production 
benefits, sometimes as high as 15% increases in production. We 
at Hyprotech and Baker Jardine aim to bring you the commercial 
software tools to achieve these gains.

Hyprotech and Baker Jardine have announced an alliance aimed 
at producing the first fully integrated, commercial Production 
System Model. In this, the first product from our alliance, Baker 
Jardine’s industry leading wellbore, tubing, and flowline 
simulation software, PIPESIM, has been coupled into 
Hyprotech’s HYSYS simulation environment, allowing for the 
development of models from well description through the entire 
process production facilities sharing common PVT descriptions 
from the HYSYS thermodynamics.

Existing PIPESIM production models of wells, flowlines, and 
risers can be imported into the HYSYS environment and used 
seamlessly as a HYSYS unit operation using the power of the 
PIPESIM engine in the background. This first release is limited to 
a serial string of devices within the PIPESIM model where there 
is no change in composition; all composition changes are 
handled within the HYSYS environment. However, one can add 
multiple PIPESIM extensions to any HYSYS simulation. 
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5.1.1 How This Chapter Is 
Organized

This chapter is a comprehensive guide that details all the 
procedures you need to work with the PIPESIM Link extension. 
To help you learn how to use PIPESIM Link efficiently, this 
chapter thoroughly describes the views and capabilities of the 
PIPESIM Link as well as outlining the procedural steps needed 
for running the extension. The basics of building a simple 
PIPESIM Link model is explored in the tutorial (example) 
problem. The case is presented as a logical sequence of steps 
that outline the basic procedures needed to build a PIPESIM Link 
case.

This chapter also outlines the relevant parameters for defining 
the entire extension and its environment. Each view is defined 
on a page-by-page basis to give you a complete understanding 
of the data requirements for the components and the 
capabilities of the extension.

The PIPESIM Link chapter does not detail HYSYS procedures and 
assumes that you are familiar with the HYSYS environment and 
conventions. If you require more information on working with 
HYSYS, please refer to the HYSYS User Guide. In this chapter, 
you will find all the information you require to set up a case and 
work efficiently within the simulation environment. If you 
require more information regarding PIPESIM 2000 please refer 
to the PIPESIM 2000 reference manuals.
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5.1.2 Disclaimer
PIPESIM Link is the proprietary software developed jointly by 
Hyprotech, a subsidiary of Aspen Technology Inc., (hereafter 
known as Hyprotech) and Baker Jardine & Associates Limited 
(hereafter known as Baker Jardine).

Neither Hyprotech nor Baker Jardine make any representations 
or warranties of any kind whatsoever with respect to the 
contents hereof and specifically disclaims without limitation any 
and all implied warranties of merchantability of fitness for any 
particular purpose. Neither Hyprotech nor Baker Jardine will 
have any liability for any errors contained herein or for any 
losses or damages, whether direct, indirect or consequential, 
arising from the use of the software or resulting from the results 
obtained through the use of the software or any disks, 
documentation or other means of utilisation supplied by 
Hyprotech or Baker Jardine.

Hyprotech and Baker Jardine reserve the right to revise this 
publication at any time to make changes in the content hereof 
without notification to any person of any such revision or 
changes.
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5.2 PIPESIM Link 
Extension

The PIPESIM Link Extension is a unit operation for using the 
PIPESIM software package used to simulate pipeline systems 
within the HYSYS framework. The PIPESIM Link functions in the 
same manner as any HYSYS unit operation or application in 
terms of its layout and data entry methods. The view consists of 
three worksheet tabs. At the bottom of each worksheet is a 
status bar which guides data entry and indicates required 
information, as well as indicating the status of the PIPESIM 
simulation once the calculation has been initialized. 

PIPESIM has a comprehensive suite of methods and correlations 
for modeling single and multi-phase flow in production 
equipment and is capable of accurately simulating a wide range 
of conditions and situations. You have the option of using the 
default correlations for the PIPESIM calculations, or specifying 
your own set from the list of available methods for each 
parameter. Any change to the PIPESIM models must be done 
from within the PIPESIM environment.

PIPESIM is fully compatible with all of the gas, liquid, and gas/
liquid fluid packages in HYSYS. You can combine PIPESIM and 
HYSYS objects in any configuration during the construction of a 
HYSYS flowsheet. PIPESIM objects can be inserted at any point 
in the flowsheet where single or multi-phase pipe flow effects 
must be accounted for in the process simulation. 
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5.2.1 PIPESIM Link Features
The PIPESIM Link extension is functionally equivalent to a 
HYSYS flowsheet operation. It is installed in a flowsheet and 
connected to material streams. Unlike a standard pipe segment, 
an energy stream is not supported. All PIPESIM Link Extension 
properties are accessed and changed through a set of property 
views that are simple and convenient to use. The starting point 
for the definition of a PIPESIM Link Operation, is the PIPESIM 
Link property view.

The PIPESIM Link property view is where the inlet and outlet 
material streams are specified. The Inlet Object and Outlet 
Object fields are read only. These fields are blank when the 
extension is first installed. Once the PIPESIM Link model has 
been selected, via the Model page, the names of the boundary 
objects within the PIPESIM Link model will be displayed

Solution is possible with connection of either a single or both 
ends of the unit operation. The following specifications are 
supported in addition to the inlet temperature that must always 
be specified if a connection.

• Inlet Connection: Inlet flow or inlet pressure
• Outlet Connection: Outlet flow or outlet pressure 

(Outlet flow specification is only supported for models in 
which as Adder/Multiplier operation is not used)

• Both Ends: Inlet flow and inlet pressure
• Inlet flow and outlet pressure
• Inlet pressure and outlet pressure

The HYSYS specifications will always override any specifications 
made within the PIPESIM model.

The following restrictions may surprise experienced HYSYS 
users:

• An outlet flow specification is not the same as an inlet 
flow specification since the PIPESIM Link model may 
manipulate the flow such that the inlet does not equal 
the outlet flow.

• Negative flowrate cases are not supported for modeling 
reverse flow.
5-6



PIPESIM Link 5-7
5.2.2 Adding the PIPESIM Link
To add a PIPESIM Link Extension to a HYSYS case:

1. Create a HYSYS case suitable for the addition of the PIPESIM 
Link Extension. As a minimum, you must create a case with 
a fluid package and two material streams.

2. From the Flowsheet menu, select Add Operation. The 
UnitOps view appears.

3. From the Categories group, select the Extensions radio 
button.

4. From the Available Unit Operations group, select 
PIPESIM Enhanced Link.

 Figure 5.1

For further details on 
creating a HYSYS case, 
refer to the Basis 
Environment chapter in 
the HYSYS User Guide.
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5. Click the Add button. The PIPESIM Link property view 
appears. 

6. On the Connections page of the Design tab, select the 
material streams from the Inlet and Outlet drop-down lists. 
If you have not yet installed these streams in the case, type 
the material stream names in the Inlet and Outlet fields. 

7. To define the stream conditions, click on the Worksheet tab 
and then the Conditions page.

Following these steps allows you to complete the installation of a 
PIPESIM Link Extension. Once the calculations are complete the 
Object Status bar will be green and state OK.

 Figure 5.2
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5.2.3 PIPESIM Link User 
Interface

The PIPESIM Link user interface is completely integrated into 
the HYSYS environment and conforms to all HYSYS usage 
conventions for operations and data entry. If you are an 
experienced user of HYSYS, you will already be familiar with all 
of the features of the PIPESIM Link user interface. If you are a 
new user, you should begin by studying the HYSYS User 
Guide, since you will need to learn more about HYSYS before 
you can use the PIPESIM Link Extension.

Like all HYSYS property views, the PIPESIM Link property view 
allows you access to all of the information associated with a 
particular item. The view has a number of tabs and on each tab 
are pages of related parameters.

5.2.4 PIPESIM Link Property 
View

The PIPESIM Link property view allows you to enter the data 
that defines the basic characteristics of a PIPESIM Link 
operation.

The the Ignore checkbox at the bottom of the property view can 
be checked if you want to disable the concurrent calculation of 
intermediate results during data entry. HYSYS completely 
disregards the operation until you restore it to an active state by 
deactivating the checkbox.

The PIPESIM Link property view is the starting point for the 
definition of any PIPESIM Link operation. The PIPESIM Link 
property view consists of the following tabs:

• Design
• Performance 
• Worksheet 

This setting is 
recommended if you have 
a slow computer and data 
processing is slowing 
down the entry process or 
if you want to delay the 
calculations until you 
have entered all of your 
data.
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Design Tab
The Design tab is used to define the connections between the 
HYSYS simulation case and the PIPESIM Link operation, to 
import and export PIPESIM cases, and to view the basis for 
tabular physical properties. 

Connections Page

The Connections page allows you to select the input and output 
material streams using the drop-down list or by typing the new 
material streams in the Inlet and Outlet fields. You can also 
enter a name for the operation in the Name field. 

 Figure 5.3
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Model Page

The Model page allows you to import, export, and edit a 
PIPESIM model.

The Original PIPESIM Model field is read only and echoes the 
original path and file name of the model that is imported via the 
Import button. 

The Import button allows you to import an existing PIPESIM 
model. Clicking the Import button opens the standard Window 
file picker view that allows model selection. Only single branch 
models identified by the *.bps extension can be selected.

The Edit Model button loads and runs the PIPESIM2000 GUI with 
the current model. If a model has not been imported then the 
PIPESIM2000 GUI contains an empty model. When the GUI is 
loaded, a work file name appears in the caption bar. The model 

 Figure 5.4

The Original PIPESIM Model field is for documentation 
purposes only since the model is embedded within the 
HYSYS model rather than referenced at the location in this 
field. It may be empty if the model has been created from 
within the link, rather than by importing an existing PIPESIM 
model.

The text editor 
allows you to 
record any 
comments or 
information 
regarding the 
PIPESIM link or 
your simulation 
case in general. 
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can be freely edited, but in order for changes to be reflected in 
the HYSYS flowsheet, it must be saved under the same file 
name.

The PIPESIM2000 GUI appears modally, so HYSYS does not 
continue its calculation until the GUI is closed. The PIPESIM 
model is saved with the HYSYS case and not recorded stand 
alone.

The Export button allows you to make a copy of the PIPESIM 
model reflecting any changes made since importing it. Clicking 
the Export button opens the standard Windows file picker view 
that allows selection of the file name. Only single branch models 
identified by the *.bps extension can be selected. Notice that 
only the configuration of the pipes and nodes will be changed. 
The source composition data is not changed to reflect the 
current composition of the feed stream in the HYSYS flowsheet.

 Figure 5.5
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The PIPESIM model may not contain any unit operations that 
change the compositions of the fluid because the PVT table 
corresponds to a single composition. Thus the following 
restrictions apply:

• Vapour/Liquid separators are not supported.
• Well completions cannot use gas lift.

If any of these constraints are violated the status bar gives an 
appropriate indication and the link will not attempt to solve.

PVT Page

The PIPESIM model solves using tabular physical properties 
generated by the chosen HYSYS property package. The PVT 
table defines the extents and granularity of the table. The table 
is regenerated using the current feed composition each time the 
link resolves. A maximum of 20 pressure and 20 temperature 
points can be specified. 

 Figure 5.6
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If you want to set the values of the pressure and temperature 
points to correspond to the internal PIPESIM default values, click 
the Set to Default button. The pressure and temperature default 
values are::

Calculations do not start unless the data is in ascending order. If 
the data is not sorted in ascending order, you can sort the data 
by clicking on the Sort button.

The Export button allows you to export the PVT table file for 
standalone use with PIPESIM.

Performance Tab
The Performance tab contains two pages that allow you to view 
a table of the profile data and to view the traditional PIPESIM 
output.

Pressure (psia)

14.50 24.95 43.51 64.98 99.93 145.0 200.0 290.1 450.1 625.7

1000 1450 2000 2901 4500 6527 10000 1450 20000 29010

Temperature (°F)

-60 -30 0 32 60 90 120 150 180 212

240 270 300 330 360 390 420 450 480 510
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Profiles Page

The Profiles page displays a tabular view of the profile data for 
the following key variables vs. axial distance along the pipe: 

• Mass Flow
• Pressure
• Temperature
• Holdup (actual volumetric)
• Velocity

 Figure 5.7
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PIPESIM Page

The PIPESIM page displays the traditional PIPESIM output. The 
type of view shown depends on the radio button you have 
selected in the View group: 

• None. Select the None radio button, if the link is within a 
recycle and/or adjust loop to minimise the overhead of 
importing the results files into the display widget.

• Output File. Displays all results and an echo of the 
PIPESIM model data.

• Summary File. Displays a summary of the calculated 
pressure/temperature/flow profile.

Pipe profiles can also be viewed by clicking the PSPLOT button 
on the PIPESIM page. The PSPLOT button loads and runs the 
PIPESIM plotting utility. 

 Figure 5.8
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The PIPESIM plotting utility can be used to display any of the 
profile results that have been calculated by PIPESIM.

The PSPLOT appears modally, so HYSYS does not continue its 
calculations until the PSPLOT is closed.

Worksheet Tab
The Worksheet tab allows you to directly edit the material 
streams that are attached to the PIPESIM Link operation without 
having to open the material streams property views.

 Figure 5.9

Refer to the Section 
1.3.1 - Worksheet Tab 
in the HYSYS 
Operations Guide for 
more information on the 
Worksheet tab.
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5.3 PIPESIM Link Tutorial
The purpose of the tutorial is to insert a PIPESIM pipeline into 
HYSYS that has a series of connecting components. In this 
example, you will go through the steps of importing a PIPESIM 
model into HYSYS. All units of measurement in this example are 
SI, but you can change these to whatever unit system you are 
accustomed to using.

For this case, a simple PIPESIM pipeline consisting of a fluid 
source, a tubing, a choke, a flowline, an operator, a second 
flowline, and a riser will be imported into HYSYS. The figure 
below shows the PIPESIM piping schematic of the system. 

 Figure 5.10
5-18



PIPESIM Link 5-19
5.3.1 Flowsheet SetUp 
Before working with the PIPESIM Link Extension, you must first 
create a HYSYS case. 

1. In the Simulation Basis Manager, create a fluid package 
using the Peng Robinson equation of state (EOS). Add the 
components methane, ethane, propane, i-butane, n-butane, 
i-pentane, n-pentane, n-hexane, nitrogen, carbon dioxide, 
and hydrogen sulphide.

2. Create a stream named Inlet in the main Simulation 
Environment and define it as follows:

Property Package Components

Peng Robinson C1, C2, C3, i-C4, n-C4, i-C5, n-C5, C6, Nitrogen, 
CO2, H2S

Name Inlet

Temperature [°C] 150

Pressure [kPa] 16000

Molar Flow [kgmole/h]  360

Comp Mole Frac [methane] 0.7540

Comp Mole Frac [ethane] 0.1696

Comp Mole Frac [propane] 0.0410

Comp Mole Frac [i-Butane] 0.0068

Comp Mole Frac [n-Butane] 0.0100

Comp Mole Frac [i-Pentane] 0.0028

Comp Mole Frac [n-Pentane] 0.0026

Comp Mole Frac [n-Hexane] 0.0060

Comp Mole Frac [Nitrogen] 0.0066

Comp Mole Frac [CO2] 0.0003

Comp Mole Frac [H2S] 0.0003
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5.3.2 Adding the PIPESIM Link 
Extension

Once the case is created, the PIPESIM Link Extension can be 
added.

1. From the Flowsheet menu, select Add Operation. The 
UnitOps view appears.

2. From the Categories group, select the Extensions radio 
button.

3. From the Available Unit Operations group, select 
PIPESIM Enhanced Link.

 Figure 5.11
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4. On the Connections page of the Design tab complete the 
page as shown in the figure below.

 Figure 5.12
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5.3.3 Importing the PIPESIM 
Case

1. Click on the Model page on the Design tab of the PIPESIM 
Link property view. 

2. Click the Import button, and select the location of the 
PIPESIM model wellmodel.bps.

3. To activate and/or to make changes to the PIPESIM model, 
click the Edit Model button. 

For the pipe to solve the PVT physical properties must be 
specified. A maximum of 20 temperature and 20 pressure 
points can be specified or defaults pressure and temperature 
points that correspond to the internal PIPESIM can be 
selected by clicking the Set to Default button. 

 Figure 5.13
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4. Click the Set To Default button on the PVT page of the 
Design Tab.

5. The HYSYS case will run and the stream results will appear 
as shown in the figure below.

6. Save your completed case as PIPESIM1.hsc.

 Figure 5.14

 Figure 5.15
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The PFD generated for the completed case, plus a material 
stream table is shown below:

5.3.4 Plotting PIPESIM Data
1. On the Performance tab, select the PIPESIM page.
2. Click the PSPLOT button to view a plot of your PIPESIM 

data. When your plot opens you will see a plot of pressure 
vs. time.

3. From the Edit menu, select Plot Setup to add temperature 
to your plot.

 Figure 5.16

 Figure 5.17

To add a table to a PFD, 
right-click on the PFD 
and select Add 
Workbook Table 
command from the 
Object Inspect menu.
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4. Click the Add button to add a new series to your plot. Select 
the Line plot type and click the OK button.

5. Click Close to exit the Plot Setup view.

6. Click the Series menu to assign data to your new series.

7. From the Select Right Y Axis drop-down list, select 
Temperature (C) and then click the OK button.

 Figure 5.18
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When you are finished making these changes your plot will 
look like the figure below.

 Figure 5.19
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6-2 Introduction
6.1 Introduction
PIPESIM NET is a data model and solver used for the solution of 
network models. HYSYS links to compositional PIPESIM NET 
models.

HYSYS also links to the black oil PIPESIM NET models, which 
allow modeling of Gas Lift systems and faster execution speed 
for the PIPESIM NET models.

For information on the PIPESIM 2000 Open Link, refer to the 
Baker Jardine PIPESIM Reference manual.

The PIPESIM 2000 GUI is used for editing and calculating 
PIPESIM NET models.

Open Link is an ActiveX component that allows programmatic 
access to data within and execution control of the PIPESIM NET 
models.

6.2 PIPESIM NET 
PIPESIM NET is a unit operation for using the PIPESIM software 
package used to simulate pipeline systems within the HYSYS 
framework.

HYSYS and PIPESIM 2000 must be installed prior to adding 
the PIPESIM NET unit operation.
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6.2.1 PIPESIM NET Property 
View

There are two ways that you can add a PIPESIM NET to your 
simulation:

1. From the Flowsheet menu, click Add Operation. The 
UnitOps view appears.

2. Click the Upstream Ops radio button.

3. From the list of available unit operations, select PIPESIM.

4. Click the Add button. 

OR

1. From the Flowsheet menu, click Palette. The Object 
Palette appears.

2. Click on the Upstream Ops icon. The Upstream Palette 
appears.

3. Double-click the PIPESIM NET icon. 

 Figure 6.1 

You can also add the 
PIPESIM NET by clicking 
the F12 hot key.

You can also open the 
Object Palette by clicking 
the F4 hot key.

Upstream Ops icon

PIPESIM NET icon
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The PIPESIM property view appears.

• To delete the PIPESIM operation, click the Delete 
button. HYSYS will ask you to confirm the deletion.

• To ignore the PIPESIM during calculations, activate the 
Ignored checkbox. HYSYS completely disregards the 
operation (and cannot calculate the outlet stream) until 
you restore it to an active state by deactivating the 
checkbox.

6.2.2 Design Tab
The Design tab consists of the following pages:

• Model
• Sources
• Sinks
• Variables
• User Variables
• Notes

 Figure 6.2

You can also delete the 
PIPESIM by clicking on 
the PIPESIM icon on the 
PFD and pressing the 
DELETE key.
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Model Page
The Model page allows you to link to the PIPESIM NET model. 
The name of the operation can be changed in the Name field. 

The Model page consists of three groups:

• PIPESIM Model
• PIPESIM Engine
• Property Model

PIPESIM Model Group

The PIPESIM Model group contains options than enables you to 
configure the location of files used by PIPESIM Net.

• The Original File, On Computer, and Imported On 
fields are read only fields that display the imported 
PIPESIM NET model information. 

• The XML Location field displays the location for the 
PIPESIM NET model files, if the HYSYS case is managed 
as an XML file. If the field is empty then the model files 
are in the same directory as the HYSYS case. The models 
files are the *.bpn, *.out, *.sum, and *.pns files for the 
model plus the *.plc and *.plt files for any PIPESIM NET 
objects that contain profile information.

 Figure 6.3
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• The Work Directory field is a read only field that is 
displayed solely to assist in the diagnosis of computer 
system related problems such as low free disk space.

• The Browse button allows you to select an existing 
PIPESIM NET model (.bpn file).

The selected model is embedded within the HYSYS case, 
which provides complete portability of the model within a 
single HYSYS file (.hsc). During a HYSYS session, 
temporary copies of the files that comprise the model are 
automatically managed in the Work Directory.

 Figure 6.4

You can select an existing PIPESIM NET model (.bpn file) 
from the case studies that are available when you have 
installed PIPESIM. These case studies are located on 
C:\\Program Files\Schlumberger\PIPESIM\Case Studies.
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• The Edit button allows you to edit the PIPESIM NET 
model once it has been embedded within the HYSYS 
case. It modally launches the PIPESIM 2000 GUI and 
automatically loads the PIPESIM NET model.

Once you have finished editing the PIPESIM NET model, 
you can save it from within the PIPESIM GUI then exit 
the PIPESIM GUI. The PIPESIM NET model file 
modification date/time is checked against the pre-edit 
value to determine if any changes have been made. The 
model name must not be changed by Save...As when 
saving the model within PIPESIM 2000.

• The Export button allows you to export the embedded 
PIPESIM NET model file.

• The Clear button clears the contents of the embedded 
model. This works by embedding the empty template 
model file newmodel.bpn located in the HYSYS \support 
subdirectory. This is the state of the link when the 
instance is first created.

 Figure 6.5
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PIPESIM Engine Group

In the PIPESIM Engine group there are three checkboxes:

Property Model Group

From the Property Model group, contains two radio buttons that 
enables you to toggle between the following property model:

• Compositional
• Black Oil

Checkbox Description

Run 
Minimised

Run Minimised causes the PIPESIM NET engine process to 
open minimised on the task bar rather than full screen. 

Restart Restart causes the PIPESIM NET engine to initialise the new 
solution from the last solution, useful for case studies, 
optimisation and recycle calculations.

Delete 
COMPMAN 
Files

Deletes the compositional work files created by PIPESIM 
NET in the Windows Temporary directory, each time the link 
is executed.

When creating a new/empty *.bpn model, the default 
property model is Compositional.

The PIPESIM Engine is 
controlled by the Run 
Minimised and Restart 
checkboxes.
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Sources Page
The Sources page allows you to specify the feed stream and 
PIPESIM object.

When you have selected a feed stream from the Streams 
column drop-down list, you can also select the PIPESIM object 
from the PIPESIM Object column drop-down list. The 
PIPESIM Object Type column shows the type of object based 
on the PIPESIM object you selected in the PIPESIM Object 
column. 

If the Transfer Composition checkbox is selected as shown in 
the figure above, then the composition of the feed 
(compositional or black oil model) is transferred between HYSYS 
and PIPESIM each time the PIPESIM engine is executed.

 Figure 6.6

The transfer is forward only (HYSYS to PIPESIM), and the 
transfer is in addition to any specifications on pressure, 
temperature, and mass flow. Negative flow rates are not 
supported.

The PIPESIM model must contain at least one sink pressure 
specification made either within the PIPESIM model or from 
HYSYS.
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Sinks Page
The Sinks page allows you to specify the product stream, and 
PIPESIM object. 

When you have selected a product stream from the Streams 
column drop-down list, you can also select the PIPESIM object 
from the PIPESIM Object column drop-down list. The 
PIPESIM Object Type column shows the type of object based 
on the PIPESIM object you selected in the PIPESIM Object 
column. 

If the Transfer Composition checkbox is selected, then the 
composition of the product (compositional or black oil model) is 
transferred between HYSYS and PIPESIM each time the PIPESIM 
engine is executed.

 Figure 6.7
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Variables Page
The Variables page allows you to interact with any PIPESIM NET 
data variable that is available via the Open Link. The variables 
have either read or write access with the exception of the depth 
of sub-equipment within the PIPESIM NET tubing model.

Open Link is an ActiveX component that allows programmatic 
access to data within and execution control of the PIPESIM NET 
models.

 Figure 6.8
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PIPESIM Variable Navigator View

When you click the Add or Edit button in the Variables page of 
the PIPESIM Net property view, the PIPESIM Variable Navigator 
appears. 

This view contains a list of available PIPESIM objects and the 
associated variable names. The Variable Name list contains a 
list of all the supported properties for the selected PIPESIM 
Object.

In the Variable Description field, you can enter the name for 
each variable to be added to the list of Selected Variables on the 
Variables page of the PIPESIM Net property view.

User Variables Page
The User Variables page allows you to create and implement 
variables in the HYSYS simulation case.

 Figure 6.9

The PIPESIM objects colon “:” indicates a new level within 
the PIPESIM model. W_1: VERTICAL COMPLETION 1 
indicates a single branch unit operation “VERTICAL 
COMPLETION 1” in network unit operation “W_1”. 

An additional level can apply for sub-equipment within a 
tubing unit operation. 

For more information on 
implementing the User 
Variables, refer to 
Chapter 5 - User 
Variables in the HYSYS 
Customization Guide.
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Notes Page
The Notes page provides a text editor that allows you to record 
any comments or information regarding the specific unit 
operation, or the simulation case in general. 

6.2.3 Property Model Tab
The Property Model tab consists of the following pages:

• Compositional
• Black Oil

Compositional Page
You can map boundary compositions on the Compositional page.

In the Boundary Class group, you can click on the Sources or 
Sinks radio button to define the component map. Component 
maps are defined for transfer of the composition between 
HYSYS and PIPESIM NET which defines the Sources component 
map, and between PIPESIM NET and HYSYS which defines the 
Sinks component map. 

 Figure 6.10

For more information, 
refer to Section 7.20 - 
Notes Manager in the 
HYSYS User Guide.
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For the Sources boundary class, the first column of the 
component mapping table (in the figure above) shows a list of 
components in the HYSYS flowsheet that contains the PIPESIM 
NET link unit operation.

For the Sinks boundary class, the first column of the component 
mapping table shows the list of components in the PIPESIM NET 
model.

The transfer of the composition is based on the selected basis 
type in the Transfer Basis group. There are three types of basis 
available: Molar, Mass, or Liq. Vol., each basis is associated to a 
radio button.

The Compositional page has the following buttons:

 Figure 6.11

Button Description

Clear Resets all mapping factors to zero for the selected row.

Clear All Resets all mapping factors to zero for all rows.

Normalise Normalises the mapping factors to 1 for the selected 
row.

Normalise All Normalises the mapping factors to 1 for all rows.

Import 
Hypotheticals

Imports the definitions of any hypothetical (petroleum 
fraction) components into the list of HYSYS 
components.
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When a PIPESIM NET model is first imported into the link, the 
component maps are automatically initialized where possible. 
The file pscomps.sdb in the HYSYS\Support subdirectory 
contains the mapping between HYSYS and PIPESIM 2000 
component names.

Black Oil Page 
The options in this page is not yet available for the current unit 
operation.

6.2.4 Performance Tab
The Performance tab consists of the following pages:

• Profiles
• Text

Profiles page
You can view the PIPESIM NET results on the profiles page.

 Figure 6.12
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Adding and Editing Profiles
1. In the Profiles page, click the Add button to add a profile or 

click the Edit button to edit a profile.
The Profile Editor appears.

The Add button adds to the Profile List after the currently 
selected profile, whereas the Insert button adds to the 
Profile List before the currently selected profile.

2. From the Selection group, select the PIPESIM NET unit 
operation you want to add to the profile. 

3. Click the Add or Insert button. 

The Add button adds to the PIPESIM Object list after the 
currently selected PIPESIM Object, whereas the Insert 
button adds to the PIPESIM Object list before the currently 
selected PIPESIM Object.

If you want to display profile data, select the Display Profiles 
checkbox. The extraction of profile data from the PIPESIM 
NET output files is a slow operation. Disabling the display of 
profile data during recycle, optimization or case study 
calculations can significantly increase the speed of 
execution. The profiles can be displayed after the 
calculations are complete.

 Figure 6.13
6-16



PIPESIM NET 6-17
4. The selected PIPESIM NET unit operation appears in the 
PIPESIM Object list of the Profile group. 

If you want to remove the PIPESIM Object from the profile, 
select the PIPESIM Object you want to remove and click the 
Delete button.

You can select the Reverse checkbox if you want to reverse 
the profile information for the PIPESIM Object. This is 
required to correctly display the profile when you have 
reverse flow through the PIPESIM Object.

5. In the Profile Name field, type the name for the profile and 
press ENTER.

The profile name appears in the Profile List of the Profiles 
page.

6. Click the OK button to return to the Profiles page.

If you want to remove the profile name from the Profile List, 
select the profile name and click the Delete button.

 Figure 6.14
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Viewing Profiles

You can define composite profiles that contain multiple network 
unit operations, which allows you to view the profile between 
the source and the sink. 

When you click the View Table button of the Profiles page, a 
tabular view of the calculated data for the selected profile 
appears. The figure below shows an example of a tabular view.

When you click the View Graph button of the Profiles page, a 
graphical view of the calculated data for a specific variable for 
the selected profile appears. The figure below shows an example 
of a graphical view.

 Figure 6.15

 Figure 6.16
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Launching PSPLOT

PSPLOT allows you to view the calculated profiles for the unit 
operation within the PIPESIM NET models. To launch PSPLOT, 
click the PSPLOT button of the Profiles page. 

You can view the profiles as a graph or table by clicking on the 
Graph or Data tab of the PSPLOT program.

 Figure 6.17
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Text Page
On the Text page you can view the PIPESIM NET output files 
content. 

In the View Output File group, the radio buttons allow you to 
display the contents of the results files. The are four radio 
buttons: None, Output (.out), Summary (.sum) or 
Results(.pns). The figure above shows the output file contents 
when the Output radio button is selected. 

 Figure 6.18
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The figure below shows the Summary and Results output file 
contents.

If processor/calculation speed is of importance, you can select 
the None radio button because the Output File contents are 
updated after every calculation.

You can print the contents of the displayed output file by right-
clicking on the output file contents. The object inspect menu 
appears.

 Figure 6.19

 Figure 6.20

Summary Output File Contents

Results Output File Contents
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Gas Lift Page
The Gas Lift page enables you to configure the Detailed or 
Simple Gas Lift model.

For more information on the variable values displayed in the Gas 
Lift page, refer to the Baker Jardine PIPESIM Reference 
manual.

 Figure 6.21
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Profile Ends Page
The Profile Ends page displays the profile end properties of the 
PIPESIM Net operation.

6.2.5 Worksheet Tab
The Worksheet tab contains a summary of the information 
contained in the stream property view for all the streams 
attached to the unit operation. The Conditions and Composition 
pages contain selected information from the corresponding 
pages of the Worksheet tab for the stream property view. 

The Properties page displays the property correlations of the 
inlet and outlet streams of the unit operations. The following is a 
list of the property correlations:

 Figure 6.22

• Vapour / Phase Fraction • Vap. Frac. (molar basis)

• Temperature • Vap. Frac. (mass basis)

• Pressure • Vap. Frac. (volume basis)

• Actual Vol. Flow • Molar Volume

• Mass Enthalpy • Act. Gas Flow

• Mass Entropy • Act. Liq. Flow

• Molecular Weight • Std. Liq. Flow
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• Molar Density • Std. Gas Flow

• Mass Density • Watson K

• Std. Ideal Liquid Mass Density • Kinematic Viscosity

• Liquid Mass Density • Cp/Cv

• Molar Heat Capacity • Lower Heating Value

• Mass Heat Capacity • Mass Lower Heating Value

• Thermal Conductivity • Liquid Fraction

• Viscosity • Partial Pressure of CO2

• Surface Tension • Avg. Liq. Density

• Specific Heat • Heat of Vap.

• Z Factor • Mass Heat of Vap.

The Heat of Vapourisation 
for a stream in HYSYS is 
defined as the heat 
required to go from 
saturated liquid to 
saturated vapour. 
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7-2 Introduction
7.1 Introduction
The GAP unit operation provides a link between HYSYS and 
Petroleum Experts. 

With this operation, you can import a GAP simulation model, 
export streams from a HYSYS simulation case into the GAP 
model, perform calculations and use the capabilities of the GAP 
model to generate product streams, and import the product 
streams back into the HYSYS simulation case for further analysis 
or processing.

In essence, the GAP unit operation acts as a black box using 
streams and fluids to characterize the input and output 
boundaries of the GAP model from Petroleum Experts software.

7.2 GAP Property View
There are two methods to add a Petroleum Experts GAP to your 
simulation:

1. From the Flowsheet menu, click Add Operation. The 
UnitOps view appears.

2. Click the Upstream Ops radio button.

3. From the list of available unit operations, select Petroleum 
Experts GAP.

4. Click the Add button. 

OR

The GAP unit operation is for advance users of Petroleum 
Experts software. Refer to the Reference manuals provided 
by the Petroleum Experts for detailed information on using 
GAP models.

You can also access the 
UnitOps view by pressing 
F12.
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1. From the Flowsheet menu, select Palette (or press F4). 
The Object Palette appears.

2. In the Object Palette, click the Upstream Ops icon to open 
the Upstream Object Palette.

3. In the Upstream Object Palette, double-click the Petroleum 
Experts GAP icon.

The GAP property view appears.

To delete the GAP operation, click the Delete button. HYSYS will 
ask you to confirm the deletion.

 Figure 7.1

 Figure 7.2

Petroleum Experts GAP 
icon

You can also delete a 
GAP operation by 
clicking on the GAP icon 
on the PFD and pressing 
DELETE.
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To ignore the GAP during calculations, select the Ignored 
checkbox. HYSYS completely disregards the operation (and 
cannot calculate the outlet stream) until you restore it to an 
active state by clearing the checkbox.

7.2.1 Design Tab
The Design tab consists of the following pages:

• Model
• Configurations
• Equip Specs
• User Variables
• Notes

Model Page
The Model page is used to select the GAP model and define all of 
the stream connections to the objects in the selected GAP 
model.

 Figure 7.3
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The following table lists and describes each option in the Model 
page:

Object Description

Name field Enables you to modify the name of the GAP 
operation.

Original File field Displays the location and name of the original GAP 
model attached to the operation.
The imported GAP file cannot be modified.

Select button Enables you to find and select the original GAP 
model file.

Working File field Displays the location and name of the working 
GAP model attached to the operation.
When you make modifications to the GAP model 
attached to HYSYS, a working GAP model 
(containing the changes) is created. The purpose 
of this feature is to enable you to make 
modifications to the copy of the imported GAP file.

Select button Enables you to save the working GAP model file.

Clear All button Enables you to clear all data model and stream 
attachments to the GAP operation.

Calculate button Enables you to propagate the calculated results 
from the GAP model back into the HYSYS 
simulation case.

Source Stream 
column

Enables you to select and connect source/inlet 
streams from HYSYS simulation case to objects in 
the selected GAP model.

GAP Object Name 
column

Displays the available inlet streams from the 
objects in the selected GAP model.

Sink Stream column Enables you to select and connect sink/outlet 
streams from HYSYS simulation case to objects in 
the selected GAP model.

GAP Object Name 
column

Displays the available outlet streams from the 
objects in the selected GAP model
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Configurations Page
The Configurations page allows you to configure the Petroleum 
Experts GAP operation. There are two configuration options for 
the GAP operation: System Settings or Property Model. 

Depending on which configuration option you selected, the 
following variables are available for you to configure the GAP 
operation:

• If you select System Settings radio button. 

The Property Model configuration is only applicable to a GAP 
model that is Compositional (in other words, not BlackOils).

 Figure 7.4
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The following variables are available:

Object Description

System Type drop-
down list

Enables you to select the type of system for the 
GAP operation. You have the following selection:

• Production
• Water Injection
• Gas Injection

Optimization Method 
drop-down list

Enables you to select the optimization method for 
the GAP operation. You have the following 
selection:

• Production
• Revenue
• Oil Rate Only
• Gas Rate Only
• Water Rate Only

Prediction Status 
drop-down list

Enables you to toggle between activating (select 
On) or ignoring (select None) the selected 
prediction method.

Prediction Method 
drop-down list

Enables you to select the prediction method for 
the GAP operation. You have the following 
selection:

• Pressure Only
• Pressure And Temperature

Solving Method drop-
down list

Enables you to select the solving method for the 
GAP operation. You have the following selection:

• No Optimization
• Optimization With Constraints
• Optimization WithOut Constraints

Oil Viscosity 
Correlation drop-
down list

Enables you to select the correlation for the oil 
viscosity in the GAP operation. You have the 
following selection:

• Beal et al
• Beggs et al
• Petrosky et al

Gas / Liquid pipe 
GOR Cutoff field

Enables you to specify the gas liquid ratio value of 
the pipe gas oil ratio cutoff.

Oil, Bo Correction 
field

Enables you to specify the Bo correction value for 
the oil calculation.

Gas, Bg Correction 
field

Enables you to specify the Bg correction value for 
the gas calculation.

The selected optimization 
method is not applicable 
if the selection for the 
Solving Method drop-
down list is No 
Optimization.
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• If you select Property Model radio button. 

The following variables are available:

 Figure 7.5

Object Description

Property Model field Displays the property package of the selected GAP 
model.

Associated Model 
field

Displays the name of any models associated to the 
selected GAP model.

Sources radio button Enables you to access the HYSYS vs. GAP 
component table for source/inlet streams.

Sinks radio button Enables you to access the HYSYS vs. GAP 
component table for sink/outlet streams.

HYSYS vs. GAP table Enables you to specify the ratio value of 
components flowing between the HYSYS and GAP 
model.
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Equip Specs Page
The Equip Specs page allows you to specify GAP object variable 
values. Depending on the selected GAP model, not all GAP 
objects will be available for configuration.

The radio buttons at the top of the Equip Specs page enables 
you to select which possible group of GAP objects you can see 
and modify. 

The GAP objects are split into the following groups:

• Wells
• Separators

User Variables Page
The User Variables page allows you to create and implement 
variables in the HYSYS simulation case. For more information on 
implementing the User Variables, refer to Chapter 5 - User 
Variables in the HYSYS Customization Guide.

 Figure 7.6
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Notes Page
The Notes page provides a text editor that allows you to record 
any comments or information regarding the specific unit 
operation, or the simulation case in general. 

7.2.2 Performance Tab
The Performance tab displays the calculated performance results 
of the Petroleum Experts GAP operation.

Results Page
The Results page displays the calculated results of the objects in 
the GAP model.

Use the radio buttons at the top of the Results page to access 
the calculated results of the following objects:

• Wells
• Separators
• Pipes

 Figure 7.7

For more information, 
refer to Section 7.20 - 
Notes Manager in the 
HYSYS User Guide.
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• Chokes
• Tanks

Report Log Page
The Report Log page displays the calculation logs.

7.2.3 Worksheet Tab
The Worksheet tab contains a summary of the information 
contained in the stream property view for all the streams 
attached to the operation. 

 Figure 7.8

Refer to Section 1.3.1 - 
Worksheet Tab in the 
HYSYS Operations 
Guide for more 
information.
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